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Software License Agreement

This is a legal agreement between CELSYS, Inc., TRIMEDIA, Inc. (the

"Manufacturer") and you (the "User"), covering your use of the software program.

TITLE
This program is the property of the manufacturer. It is protected by international

copyright laws and treaties. You have only the limited rights granted by this licenses.

You are not the lawful owner of any copy of the program and you may not under any

circumstances distribute copies of the program.

LICENSE
(1) You may use the program on a single machine.

(2) You may not make copies of the program other than for backup purpose.

(3) You may transfer the program and license to another party if the other party

agrees to accept all terms and conditions of this Agreement.

(4) You may not modify the content, the code or the copyright information of the

program.

(5) You may not reproduce the package or the manual, in whole or in part, in any

form or by any means without permission other than for backup purposes.
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TERMINATION
 The license will terminate automatically if you discontinue using the program, or

transfer the program and the license, or fail to comply with the limitations described

herein.

 On termination, you must destroy all copies of the program and accompanying

documentation.

LIMITATIONS
 The manufacturer makes no guarantee of future updates for additional features or

improving performance. In no event will the Manufacture or its dealers be liable to you

for any damages occurring from the use of or inability to use this program.

CELSYS, Inc.

3F Fuji Building 25

Yoyogi 4-27-25, Shibuya

Tokyo151-0053

JAPAN

http://www.celsys.co.jp

TRIMEDIA, Inc.

148 North Le Doux Road

Beverly Hills, CA 90211

USA

http://www.trimediaweb.com
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User Support

User Registration
User registration is very important for us to confirm your purchase of the software. If

you do not register, you may not receive future updates or services we provide.

Please register at RETAS!PRO home page.

RETAS! PRO Home Page
The RETAS! PRO Home Page will give you the latest technical information about

RETAS! PRO series, and allow you to download updates.

RETAS! PRO Home Page

URL: http://www.retas.com

Dongle Replacement
If the dongle of RETAS! PRO is damaged, it can be replaced by your local dealer

free of charge within 90 days of purchase. This free replacement is only provided to

users who have sent in their User Registration Card.

After 90 days, basic costs may apply. For further information, please contact your

dealer.
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CoreRETAS Introduction

1. Main Features
X-sheet User Interface

The user interface of CoreRETAS is based on the exposure sheet used in traditional

animation production.

This gives you a smooth translation from conventional animation production to digital.

Camera Simulation
Animation camera shooting is simulated in the computer.

CoreRETAS allows you to set up camera work which is equivalent to that of traditional

camera shooting.

Keyframe InBetween
Camera and cel coordinates and special effects parameters can be automatically

inbetweened through the use of keyframes.

Graphical Speed Setup
You can use a graph to set up more sophisticated inbetweening speed.

Antialias
Mono traced image can be anti-aliased which will get rid of the rough edged lines and

produce better looking images.

Various Compositing Modes
[Sample compositing modes]

Alpha, Add, Subtract, Lighter, Darker, Difference, Multiply, Screen, Backlight, Gray Mask.

Telecine
X-sheets input in 24 fps can be converted to 30 fps (3:2 pulldown) for video output.

Special Effects
Both traditional animation special effects and new digital special effects.
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Flicker Free
Vertical lines shake (flicker) on a video monitor can be reduced with this feature.

High Speed Recording Onto Digital Disk Recorder (DDR)
A digital disk recorder can be controlled through SCSI or a network (TCP/IP) for high speed

recording.
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2. Changes In New Version

2-1. New X-sheet Interface
For better flexibility, the RETAS! PRO ∞ (Infinity) x-sheet has been redesigned.

Multi-sheet Import
Multiple x-sheets can be opened simultaneously - the number limited only by system

memory.

Sheet Nesting
CelBank can import not only images, but also x-sheets.

Sheet Nesting (sheet-in-sheet) can be used to simplify overlays.

Free Combination of Layer & CelBank
When multiple layers share the same images, they don't need to be imported twice.

"Pegbar" Group
Layers can be grouped by "Pegbar". By moving the pegbar, the movement of all grouped

layers can be synchronized.

"Upper Cel" & "Lower Cel" Layer Structure
"Upper Cel" & "Lower Cel" combined-layers can be treated and controlled as a single layer.

Special Effects Are Plug-ins
All special effects are now plug-ins.

Many new plug-in filters are scheduled to be released in the future.

Effects Layer Structure
Special effects are now layers.

Different from old plug-in filter behavior, filters now are applied to desired layers only.

Filter processing order is also controllable.
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Timing Preview
Previews can be created by layer.

Animation check displays according to the timing in the x-sheet.

Scene Folder System
"Scene Folder System" has been implanted for management of the scenes.

The Scene folder system provides more effective asset management.

Camera Work's Measurement Settings
Camera Work measurement setup can use "inch" and "mm".

Sheet Marking
Sheet marking allows the user to go to specified markers in an x-sheet.

Z Axis
The cel's "depth" can be controlled through the Z axis.
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2-2. Stage
Easier View

Layers grouped by same pegbar are shown in the same color.

Current Pegbar & Current Layer Switch
A desired pegbar or layer can be selected to avoid confusion with other pegbars and layers.

Precise Unit Control of Pegbar & Layer
Each layer and pegbar has its own offset parameters.

2-3. Rendering
Rendering speed has been increased approximately 200%.

2-4. InBetween
Sophisticated Keyframes

Each parameter, such as the X coordinate or Y coordinate, has its own keyframes.

Both continuous-keyframe and noncontinuous-keyframe can be configured.

Fairing In Follow
Movement fairings have both Ease In and Ease Out settings.

Easier InBetween Dialogue
The "Graph Setup" has been embedded.

Center Point InBetween
Each frame's center point coordinates can be configured and inbetweened.
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2-5. Export
Writing to hard disk and recording to DDR can be performed

simultaneously.

Multiple Export Destinations
Up to 4 disks can be set as export destinations.

If the first disk is full, export will automatically change to the second disk.

DDR Control In Export Dialogue
DDR is controlled by the export dialogue which controls functions such as starting time or

frame jump.

2-6. Special Effects Plug-in
Soft Blur, Focus, Noise, Backlight-1, Backlight-2, Mask Replace, HSV Filter, RGB Filter,

Invert, Mirror, Distort, Alpha, Smoothing, etc.

More plug-in filters are scheduled to be released in the future.

2-7. Shortcut
Function keys allow windows and palettes to be selected with one

touch.
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3. Image File Management
Certain rules such as the scene folder structure and file name are established. For details,

please see "Technical Information".

4. File Extensions
RETAS! PRO ∞ Mac OS version automatically adds a file extension for compatibility with

Windows.

5. Import & Export Format

Please see "Appendix".
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1. Before Installation
This manual is written in a way which assumes you already have the following knowledge of

basic computer operation:

•Starting and turning off the computer

•Basic use of the mouse (click, double-lick, drag, etc.)

•Basic operation of files (create folder, move a file, copy, delete, etc.)

•Basic knowledge of personal computer (SCSI, hard disk, monitor, sort, etc.)

For basic operation information, please refer to the user's manual that comes with your

computer.

2. Package Verification
Before installation, please verify the contents of CoreRETAS package:

•[RETAS! PRO Infinity] disk (CD-ROM) 1

•User's Manual (this book) 1

•Hardware Dongle (MicroGuard/HASP) 1

•Keyboard Shortcut List 1

If anything is missing, please contact your dealer.

Setup Guide
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3. System Requirements
CoreRETAS has the following system requirements:

PC Compatible

CPU : Pentium, Pentium Pro, Pentium MMX, Pentium II,

 Celeron, Pentium III and compatibles

Clock Speed : 200 MHz or up recommended

Memory : minimum 90 MB, 128 MB or up recommended

Monitor Resolution : SVGA (800x600 pixel) or higher

Monitor Color : full color (16,7 million) required

Hard Disk : 20 MB or higher available

OS : Windows 98/NT 4.0 (SP3 or higher)

Other : printer port required for dongle

 QuickTime (3.0 or higher) recommended

Macintosh

CPU : PowerPC 601, 603, 604, G3 (iMac compatible)

Clock Speed : 200 MHz or higher recommended

Memory : minimum 90 MB, 128 MB or higher recommended

Monitor Resolution : 15 inch (800x600 pixel) or higher

Monitor Color : full color (16,7 million) required

OS : Mac OS 8 or higher, Mac OS 8.6 compatible

Other : ADB or USB port required for dongle

 QuickTime (3.0 or higher) required

Please confirm the above requirements before use.
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4. Dongle Installation
A hardware dongle (MicroGuard/HASP) is required to use RETAS! PRO, .

Before installing the dongle, quit all running applications and turn off the computer.

PC Compatible
Connect the dongle to the printer port.

Make sure it's properly connected and then restart the computer.

To use multiple RETAS! PRO applications, multiple dongles need to be placed inline.



16

Chapter 4    Setup Guide

Macintosh (ADB port)

Macintosh (USB)

Note: The USB dongle is for Macintosh only. (As of October 1999)

Third party USB boards on PCI cards are not supported.
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Note:

• Do not connect or disconnect the dongle if the computer is turned on. This may damage the

dongle.

• The dongle is sensitive to electronic fields, it needs to be stored under low humidity conditions

when not in use.

• If the dongle is damaged, the software may not launch.

• The dongle has a serial number on it. This number is required in case of repair, so please

record it below.

 (Dongle Number Memo)

(                                                                               )
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5. Software Installation
Windows Version Installation

Note:

Windows NT 4.0 requires the user to log on as Administrator before installation.

1. Start The Installer Program
Find the Program/CoreRETAS folder in the CD-ROM and double-click the Setup.exe.

CoreRETAS setup program starts.

2. Installer Option
The following window appears.

Click "Next" to continue. To cancel the installation, click "Cancel".

The next panel will determine the installation destination of CoreRETAS.
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CoreRETAS will be installed in the following folder.

Note:

If other RETAS! PRO applications need to be installed on the same machine, it is highly

recommended that they be installed in the same folder. If each application is installed in a

different folder, they may not coordinate correctly.

Installing in the default folder is recommended.
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3. Installing
Installation process.

4. Finish Installation
The following dialogue appears after the installation is complete.

This creates a CoreRETAS shortcut on desktop.
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CoreRETAS installation is complete.
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Macintosh Version Installation
1. Create A Folder

Create a RETAS! PRO folder on your hard disk.

The location and name of the folder is not important, although it is easier to create a common

folder to share with other RETAS! PRO applications (TraceMan, PaintMan, etc.).

"RETAS! PRO Infinity" folder is created here.

2. Insert The Disk.
Insert the "RETAS! PRO Infinity" disk in the computer. Find the "Program " folder as shown

below.

3. Copy Into Folder
Drag the CoreRETAS folder into the "RETAS! PRO Infinity" folder to copy it.
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4. Sample Data Installation
Copy the desired sample data from the "Sample Data" folder onto your hard disk.

5. USB Driver Installation
To use USB dongle, copy the "USBMicroGuardDriver" from the "USB Driver" folder into the

"Extension" folder of your "System Folder".

Note:

"USBMicroGuardDriver" will take effect after restarting the computer.

6. Eject The Disk
Eject the "RETAS! PRO Infinity" disk and store it in a safe place.

CoreRETAS installation is complete.



24

Chapter 4    Setup Guide

6. Monitor Setup
Before using CoreRETAS, you should set up the monitor and memory (Macintosh).

CoreRETAS takes advantages of full color. Setting the monitor to full color mode is highly

recommended. Other color modes still work, but user will be unable to confirm precise color differences.

Windows
To change the display color settings, find "Display" in the "Control Panels".
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Double-click "Display", the following window appears.

Select the tab "Settings".

Select "True Color (24 bit).
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Macintosh
Find "Monitor & Sound" in the "Control Panels" of the System Folder.

Double-click "Monitor & Sound", and the following window appears.

Click "Millions".

Some machines may have different amount of VRAM or video card installed, and may be

unable to display full colors. If this is the case, add more VRAM or purchase a full color video

card.
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7. Memory Setup  
1. In the Finder, double-click the CoreRETAS icon to highlight it.

2. Use "Get Info" under "File" menu.

Choose "Get Info/Memory" under "File" menu.

3. Change the "Preferred Size" under "Memory Requirements".

4. Memory size increases dramatically if image files are large. Minimum size should

be 30 MB, 90 MB or more is recommended.

Choose "About This Computer" under the Apple menu to see the current running

application memory usage.
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ASPI Installation  

To use SCSI devices (scanner, DDR) and TraceMan and CoreRETAS on PC compatibles,

the ASPI (SCSI driver) needs to be installed.

RETAS! PRO supports Adaptec SCSI cards and the Adaptec standard ASPI driver.

Third party SCSI cards or ASPI drivers may not work properly with RETAS! PRO, even

though marked "ASPI Standard".

Windows 98 automatically installs an ASPI driver by default. This ASPI driver is an older

version (version 1.0) which contains bugs. RETAS! PRO applications do not work properly with

this old ASPI version. The latest ASPI driver should be installed.

(As of July 15,1999)

Windows NT does not install an ASPI driver by default. An ASPI driver should be installed

after the installation of Windows NT.

An ASPI driver comes with Adaptec SCSI card upon purchase. If you purchase a new

Adaptec SCSI card, the latest ASPI driver should be included.

To learn more about Adaptec products, prices and purchasing information, contact Adaptec,

Inc.

Adaptec, Inc.

http://www.adaptec.com

To learn how to install the SCSI card and ASPI driver, please refer to its manual.
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Quick Guide

Operation Procedure

We will use some sample data to explain CoreRETAS operation procedure.

1. Confirm the availability of the animation materials

2. Launch CoreRETAS

3. Import materials and set up transparency

4. Assemble the x-sheet

5. Adjust image position

6. Export images and recording

7. Save the x-sheet

8. Quit CoreRETAS

All sample data used in this Quick Guide are included in the CD-ROM.



32

Chapter 5    Quick Guide

1. Confirm The Materials
CoreRETAS operation requires painted image data and a paper based x-sheet.

1-1. Painted Images (Stored In Cut Folder)
Also confirm the scene folder structure as well.

CoreRETAS handles cels by folders. If some A level cels are mixed with B level cels, it may

be troublesome to change them later.

We will use the following sample images.

Find "C-2" folder in SampleData/CoreRETAS/Chapter V/Quick Guide.

"-BG" folder has 1 background.

"A' folder has 4 cels.

"B" folder has 35 cels.
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Composited result:

[Figure: Composited result]
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1-2. Paper Based X-sheet With Timing Settings
Used for timing guide in CoreRETAS. This is unnecessary if you prefer to do timing directly in

CoreRETAS.

[Figure: Paper x-sheet sample]
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2. Launch CoreRETAS
Double-click the CoreRETAS icon.

The splash screen appears upon start-up.

If the following warning dialogue appears, shut off the system and connect the dongle.

[Figure: Error message]
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New X-sheet dialogue appears after start-up.

The sample scene has 3 seconds and is set to 24 fps. Enter "72" frames (24 fps x 3).

Layer number should be "3", camera size is "640 x 480". Then click "OK", and a new x-sheet

window appears.

   

Note:

RETAS! PRO version 5 adds a file extension on MAC OS. MAC OS does not require file

extension, but if data transferred to Windows, an error may occur.

3. Material Import & Mode Setup
3-1. Import Into CelBank

Next import the files into a CelBank.

Choose "CelBank" under "Windows" menu and the CelBank palette appears.

Select "-BG" from the "CelBank Select Menu" at upper left.

Click "Import", and the file import dialogue appears.
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Select the image "BG.tga" in folder "-BG", then click "Open".

CelBank displays image thumbnails, location and size.
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Next import CelBank "A". Click the right arrow on the "CelBank Select Menu" to switch it to

"A".

Click "Import".

Select the A cel and click "Open", CoreRETAS imports all images in the same folder

automatically.

Same as above, import the B cel into CelBank "B".

CelBank assigns a number for each cel, called the "Cel Number" which is used for

assembling the x-sheet.

Besides the CelBank import method, you may also shift-click the "CelBank Select Menu" in
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the x-sheet to import files.

[Figure: Shift-click the CelBank Select Menu]

3-2. Mode Setup
The A cel and B cel are gray-traced, so we will use an Alpha Channel to composite them.

Choose "Layer Setup" under "Windows" menu, and the Layer Setup palette appears.

Select "-BG" from the "Layer Select Button" at the upper left.

Select "Normal" for "Mode" and "Not Transparent" for "Mask".
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Choose layer "A".

Select "Normal" for "Mode" and "Alpha Channel" for "Mask".

    

Set layer "B" to be the same as layer "A".

4. Assemble The X-sheet
Next assemble the x-sheet.

By following the example of the paper based x-sheet, the CoreRETAS x-sheet is easily

created by inputting the cel level data.

4-1. Basic Assemblage
Click the "Sync Button" at the upper left of the x-sheet to turn it on.
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                    [Sync Off]                                                                            [Sync On]

Next, make sure the "Input Parameter Menu" is set to "Cel Number". If it's not, select "Cel

Number" from this "Input Parameter Menu"

Next select the input location. Click a Data Cel in the x-sheet where you want to input a cel

number, and it will be highlighted. This highlighted area is called a "Selection". To select

multiple frames, drag the mouse.

After making a selection, input a "Cel Number". To input a cel number, type "1". The

"Parameter Input Field" at the upper left of the x-sheet displays "1". Then press "Enter" key, the

number is entered, and the selection moves down.

If 3 frames are selected, all 3 frames will have the same cel number entered. After the first

number is input, the selection automatically moves to the next section with the same number of

frames. If you want to change the number of frames within a selection, drag the selection to

redefine it.

To make a correction, select the data you want to change and input another cel number to
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correct it. To delete a cel number, enter "0".

4-2. When All Frames Need The Same Cel Number
To select the entire layer, double-click the layer's title bar (such as "-BG" or "A").
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4-3. Constant Number Of Frames
To input a constant number of frames, use "Cel Number Auto Input".



44

Chapter 5    Quick Guide

Make a selection, then choose "Cel Number Auto Input..." under "X-sheet" menu. The

dialogue appears.

    

To learn more details, go to "Menu Bar Commands".

This dialogue allows the automatic input of a selected range of cel numbers and frames.
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5. Change Cel Position
5-1. Render A Frame

After the x-sheet is assembled, confirm the composited image.

Click a frame number to select it, then choose "Render Current Frame" under the "Render"

menu. The rendered result appears in the rendering window.

If a cel or background position is shifted, you can adjust it.
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5-2. Move A Pegbar
Here we will explain how to move the B layer position.

In the Stage window, click "Pegbar" to switch to Pegbar mode.

By default, the "B" layer is linked to pegbar "#02" after creating a new x-sheet.
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Click the "Pegbar/Layer Select Button" to switch to "#02".

In "Stage Area", the current pegbar is shown as a wire frame. To move the pegbar, drag the

wire frame.

To confirm the actual image is correct, choose "Image" under "Stage".
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[Figure: "Image" mode]
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6. Export (To Hard Disk)
The following will explain how to export to a hard disk.

To learn how to record onto a disk recorder, go to "Export..." in "Menu Bar Commands".

6-1. Export
Choose "Export..." under "File" menu.

 

[Figure: "Export" dialogue]

The "Export" dialogue appears. Turn on "File Export", leave "DDR Export" off.
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Change the File Type to "QuickTime Movie".

Click "Select..." next "Save Location 1" and choose a destination.

Follow the other settings as shown in the figure.

Click "OK" when done.

The "Rendering Settings" panel appears.

     

Follow the above settings.

Click "OK" when done.
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The "Compression Settings" dialogue appears, showing QuickTime movie compression

settings.

    

Follow the above settings.

Click "OK" when done.

CoreRETAS starts to export to a QuickTime movie file.
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7. QuickTime Playback
7-1. Play The QuickTime Movie After Export

Double-click the QuickTime movie file saved on your disk.

The QuickTime Player launches a movie window.

    

To play the movie, click the Play button or double-click inside the window.
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8. Save X-sheet
To save the x-sheet, choose "Save..." under "File" menu.

The Save dialogue appears. Select a destination and enter a sheet name.

The x-sheet should be saved in its own scene folder.

It is recommended that the x-sheet name should be the same as the scene folder.

RETAS! PRO version 5 will also add a file extension on MAC OS.

Click "Save" to save the x-sheet.
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9. Quit CoreRETAS
Choose "Quit" under "File" menu to quit CoreRETAS.

If the x-sheet is not saved, the following dialogue appears, asking you to save or not.

  

Click "Save" to quit CoreRETAS with the x-sheet saved. Click "Don't Save" to quit CoreRETAS

without saving the x-sheet.

If you click "Cancel", CoreRETAS will not quit.

That's the basic operation of CoreRETAS.
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Command References
Symbol

Windows

Mac OS

Ctrl key (Windows), Command key (Mac OS)

Usually, the Windows Ctrl key and Mac OS Command key have

the same function.

Alt key (Windows), Opt key (Mac OS)

Usually, Windows Alt key and Mac OS Opt key have the same

function.

Shift key

CapsLock key

Esc key

Tab key

Return key, Enter key

Function key (Sample: F5 key)

Shortcut
Sample:

Hold the "Ctrl" key and press the "S" key.

Hold the "Ctrl" & "Shift" keys and press the "S" key.
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Menus & Palettes List

The menu bar and various floating palettes are used throughout all the operations of

CoreRETAS.

  

Windows & Floating Palettes
  A. X-sheet Window

      

Configure animation timing, composite modes and special effects.
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  B. Stage Window

Set up camera works.

  C. Z View

         

Control the pegbar's front-back relation.

  D. Rendering Window

Display rendering results.
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  E. CelBank    

Import and manage image files used by the x-sheet.

  F. Layer Setup    

Control layer settings.
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Menu Bar Commands
Menu Bar

      

The white bar on top of the screen, showing titles like "File", "Edit"... etc.

A. File
File import/export commands.

  New X-sheet...

  Open...

  Open Scene Folder...

  ------------------------------------------------------------

  Close

  Save

  Save As...

  Revert

  Save Image...

  ------------------------------------------------------------
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  Export...

  Batch Export...

  ------------------------------------------------------------

  DDR -> Control...

-> Setup...

  ------------------------------------------------------------

  Quit
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B. Edit
Editing commands & preferences settings.

  Undo

  ------------------------------------------------------------

  Cut

  Copy

  Paste

  Selected Paste...

  Insert & Paste

  Clear

  ------------------------------------------------------------

  Select All

  Select Copied Range

  ------------------------------------------------------------

  Preferences...
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C. X-Sheet
X-sheet control commands.

  Parameter Settings...

  ------------------------------------------------------------

  Cel Number Auto Input...

  Cel Auto Arrange

  ------------------------------------------------------------

  Frame -> Insert...

-> Delete...

  Layer -> Insert...

-> Delete

-> Rename...

  Pegbar -> Insert...

-> Delete

-> Rename...
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  CelBank -> Insert...

-> Delete

-> Rename...

  ------------------------------------------------------------

  Sound ->Import...

->Delete

->Play

->Stop

->Info

  ------------------------------------------------------------

  Keyframe -> Set Continuous-Keyframe

-> Set Noncontinuous-Keyframe

-> Unset

  ------------------------------------------------------------

  InBetween-> Apply

-> Current Parameter Only

-> Setup...

  Follow Setup...

  Random Input...

  Calculation...

  Reverse
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  Center Match

  ------------------------------------------------------------

  First Frame

  Last Frame

  Jump To Frame...

  Current Frame...

  ------------------------------------------------------------

  Collapse Sheet

  Expand Sheet

  ------------------------------------------------------------

  Sheet Settings -> General...

-> Info...

-> Memo...

-> In-Point...
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D. Stage
Stage control commands.

  Basic View

  Image

  Outline

  All Keyframes -> Position X, Y

-> Position Z

-> Scale

-> Rotation

-> Center

  All Frames

  Frame Path

  Show Pegbar

  ------------------------------------------------------------

  Play

  Stop

  ------------------------------------------------------------

  Zoom In

  Zoom Out
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E. Effects
Special effects control commands.

  Add -> Blur

-> Noise

-> Light

-> Composite

-> Tone

-> Distort

-> Other

  Delete

  ------------------------------------------------------------

  Setup...
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F. Render
Rendering control commands

  Render Current Frame

  ------------------------------------------------------------

  RGB View

  Alpha View

  ------------------------------------------------------------

  Zoom In

  Zoom Out

  Normal

  ------------------------------------------------------------

  Capture To Clipboard

  Send To DDR...

  ------------------------------------------------------------

  Rendering Settings...
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G. Window
Windows control commands.

  X-sheet

  ------------------------------------------------------------

  Stage

  Z View

  Rendering Windows

  ------------------------------------------------------------

  CelBank

  Layer Setup
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Windows & Palettes

X-sheet Window
To configure animation timing, compositing modes, coordinates, etc.
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X-sheet Concept

The X-sheet organizes cels (layers) in the horizontal rows and time (in frames) in the

vertical columns.

All moving components of CoreRETAS are orchestrated here including cel number,

position, scale, transparency, effect parameters, etc.

A. Frame

A horizontal row in the sheet is called "frame".

B. Current Frame

"Current Frame" is highlighted and can be edited on the Stage, shown with a wire

frame.

A current frame may be different from that of an input selection.
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C. Layer

A column in the sheet is called a "layer", and represents images in descending order.

It displays as "cam", "-BG", "A", "B", "C"... from left to right.

In the composite order, the left layer is the lower, and right layer is the upper. (Except

the camera layer.)

A maximum of 100 cel layers can be created, named by default A to Z, then AA to ZZ.

The different type of layers are as following:
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C-1. Cel Layer

To import animation cels.

C-2. Sub-cel Layer

Subordinate to a cel layer.

Mainly used for combining cels.

The left is the "Lower Layer", and the right is the "Upper Layer".

A sub-cel layer cannot contain a parameter other than a cel number, so the "Input

Parameter Select Menu" cannot be used.
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C-3. BG (Background) Layer

Only the name is different, all functions are same as other cel layers.

Normally it is set to "Opaque" mask mode.

C-4. Effects Layer

The special effects layer is attached to a cel layer or to the camera layer.
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C-5. Camera Layer

To control the camera work.

It does not contain "cel number" or "Transparency".

C-6. Sound Layer

To import sound.
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D. Current Layer
A highlighted layer is ready to be edited.

  

E. Keyframe Area

  

An area which indicates keyframes can be edited.

The keyframe area can be selected alone. It must be selected with a cel.

F. Cel
An image imported into the x-sheet, shown as a "Cel Number".

"Cel Number" is assigned by CelBank upon import.

To delete a cel in the x-sheet, enter "0" as cel number.
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G. Selection
A selected and highlighted area in the x-sheet. Multiple rows or columns can be

selected.

You can input a parameter, apply InBetween, and copy or paste to a selection. To

move a selection, use the arrow keys.

To learn how to make a selection, go to "Selection" in " Commands & Tools".

H. Pegbar  
"Pegbar" is used to group layers.

All layers linked to the same pegbar will share the same position, scale, rotation and

center parameter settings. By changing one pegbar's parameters, all linked layers'

movement will be synchronized.

H-1. Camera Pegbar  
Camera Pegbar is linked to the camera by default upon creating a new x-sheet.

Besides its name, all functions are same as other pegbars. If no specific reason, link

only the camera layer to the camera pegbar to avoid confusing with other layers.
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H-2. Current Pegbar
A selected pegbar ready to be edited.

To switch a current pegbar, use the "Pegbar/Layer Select Button" in the stage window.

H-3. Pegbar Parameters (Camera Pegbar Included)
P Position X

P Position Y

P Position Z

P Scale X

P Scale Y

P Rotation

P Center X

P Center Y

Layer Parameters
Cel Number (Note 1)

----------

Position X

Position Y

Scale X

Scale Y

Rotation

Center X

Center Y

----------

Transparency (Note 1)

Motion Blur

(Note 1: camera layer does not contain "Cel Number" or "Transparency".)
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X-sheet

A. X-sheet Name (Title Bar)

Multiple sheets can be opened simultaneously - limited only by memory.

B. Parameter Input Field

Only numbers including decimals can be entered.

After typing a number, press the keypad Enter key to input. Do not use the Return key.

C. Layer Title Bar

Displays the layer name.

Click a layer title bar to switch to the Current Layer.
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D. Cel Layer Switch

Click a cel layer (or BG layer) switch to turn a layer ON/OFF for rendering.

Effects layers can also be turned off.

E. Sub-cel Layer Switch

Click to open or close sub-cel layers (Upper Cel & Lower Cel).
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F. Effects Layer Switch

      

Click to open or close the effects layers on the right.
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G. Pegbar Select Menu

To link a layer to a selected Pegbar.

All layers linked to a same pegbar will share the same:

P Position X

P Position Y

P Position Z

P Scale X

P Scale Y

P Rotation

P Center X

P Center Y

In another word, if this pegbar is moved, all its linked layers will follow.
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H. CelBank Select Menu

To link a layer to a selected CelBank.

The "Cel Number" entered in this layer is determined by that of the linked CelBank.

In RETAS! PRO version 4, one celbank could only be used by one layer. If multiple

layers use the same cel, it had to be imported to multiple celbanks.

RETAS! PRO ∞ allows multiple layers to share one celbank.

H-1. Empty CelBank
An empty celbank does not contain any images.

A layer linked with an empty celbank will not be shown on stage, nor will it be

rendered, even if cel numbers have been entered.
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I. Input Parameter Select Menu

To select a parameter input mode for a pegbar or a layer.

Selectable parameters:

Cel Number (Note 1)

Image numbers imported in a celbank. (Integer)

------------------------------------------------------------

P Position X

    Pegbar's X coordinate.

P Position Y

    Pegbar's Y coordinate.

P Position Z

    Pegbar's Z coordinate.

P Scale X

    Pegbar's enlarge/reduce rate in the X (horizontal) direction.

P Scale Y

    Pegbar's enlarge/reduce rate in the Y (vertical) direction.

P Rotation

    Pegbar's rotation angle. Positive value is clockwise.

P Center X

    Pegbar center's X coordinate.

P Center Y

    Pegbar center's Y coordinate.
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------------------------------------------------------------

Position X

    Offset value relative to pegbar's X coordinate

Position Y

    Offset value relative to pegbar's Y coordinate

Scale X

    Offset value relative to pegbar's enlarge/reduce rate in the X direction.

Scale Y

    Offset value relative to pegbar's enlarge/reduce rate in the Y direction.

Rotation

    Offset value relative to pegbar's rotation angle. Positive value is clockwise.

Center X

    Offset value relative to pegbar center's X coordinate.

Center Y

    Offset value relative to pegbar center's Y coordinate.

------------------------------------------------------------

Transparency (Note 1)

    layer's transparency. 0 (transparent) to 100 (opaque).

Motion Blur

    Motion Blur's value. 0 (no motion blur) to 100 (strongest)

    (Note 1: camera layer does not contain "Cel Number" or "Transparency".)

Effects layers have various parameters depending on their features.

To learn more, see each plug-in filter's guide.

Sub-cel Layer only contains cel numbers, thus does not use "Input Parameter Select

Menu".
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  J. Sync Button

    

When this button is on, all other layers will follow if one layer's "Input Parameter Select

Menu" is changed.

[Sync OFF] [Sync ON]

Since the camera layer has no "Cel Number" or "Transparency", it does not sync with

other layers in these 2 modes.

Effects layers don't sync.

  K. Previous Value Display Area
If the same value appears in a subsequent cel, the x-sheet displays it as a "-" mark.

Previous Value Display Area displays the value of the cel above the first viewable cel in

the x-sheet.

If the x-sheet is scrolled down, and the cels are displayed as "-", you can still see the

value in this area.
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  L. Marker Display Area

      

Displays a marker.

A marker indicates a frame that is bookmarked.

A maximum of 10 markers can be used.

To learn more about markers, go to "Markers" in "Commands & Tools".
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M. Frame Number Display Area

Displays a frame number.

The "Current Frame", ready to edited on stage, is highlighted.

4 types of displays are selectable: "Seconds + Frames", "Feet", "Frame Number" and

"Page & Frame Number".

N. Sound Layer

Imports sound data.
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O. Sound Layer Switch

Click to open the sound layer.

Click again to close it.

    

The sound layer displays the waveform of an imported sound.
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P. Keyframe Area

Displays keyframes.

It must be selected together with data cels.

Q. Sheet Area

All data input area shown as rows and columns.

R. Data Cel

A single data input box is called "Data Cel".
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S. Information Area

Displays x-sheet information.

S-1. Current Frame Info
Sample: 20/90 Frame

It indicates the current frame is the 20th frame out of 90 frames.

S-2. Units Info
Sample: Units: pixel The current parameter unit shown in the x-sheet is "pixels".
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Stage Window

The Stage window is where to do compositing, position and scale change of current

frame or the camera. The intersection of the vertical line and the horizontal line is the

Stage's starting point.

A. Pegbar/Layer Switch Tab

Click to select either "Pegbar" or "Layer" to edit.

RETAS! PRO version 5 uses the "Pegbar" concept to easily group layers (cels).

Always select "Pegbar" to set up camera work unless there is a specific reason not to.

"Layer" is used to set an offset for a layer when you want to shift its position

independently from its pegbar.

Do not use "Layer" tab unless offset is required.
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B. Pegbar/Layer Select Button

Click the "Pegbar/Layer Switch Tab" and select "Pegbar" or "Layer" mode.

Click this button, a popup menu appears. Select a layer.

If the name is in bold, it means that this layer is linked to the current pegbar.

"Sub-cel Layer" and "Effects Layer" have no offset, thus cannot be selected here.

C. Color Select Box ("Pegbar" Only)

This box changes the wire frame color of the layers linked to the current pegbar.

Click the Color Select Box and choose a color from the Color Picker.
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D. Setup Mode Select Button
Select a mode and use the mouse to change the settings.

D-1. Position Setup  

To set up pegbar or layer position.

D-2. Scale Setup  

To set up pegbar or layer scale.

D-3. Rotation Setup  

To set up pegbar or layer rotation.

D-4. Center Setup  

To set up pegbar or layer center point.

"Center" is the starting point for "Rotation" and "Scale" of a pegbar or a layer.

D-5. Zoom Tool  
To zoom in/out the stage view.

Click where you want to zoom in.

To zoom out, hold Alt/Opt key and click.
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E. Keyframe Set Button
E-1. Continuous-Keyframe Set Button  

Sets a current frame to "Continuous-Keyframe".

When the data input area of a frame is highlighted, click this button to set it as a

"Continuous-Keyframe".

If there are other keyframes before and after this "Continuous-Keyframe", it becomes

the "center point" on InBetween.

To learn more, go to "Keyframe Settings" in "Commands & Tools".
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E-2. Noncontinuous-Keyframe Set Button  
Sets a current frame to "Noncontinuous-Keyframe".

When the data input area of a frame is highlighted, click this button to set it as a

"Noncontinuous-Keyframe".

Even if there are other keyframes before and after this "Noncontinuous-Keyframe", it

still has its own InBetween depending on its "start point" & "end point".

In other words, if there is a Noncontinuous-Keyframe in the middle of other keyframes, it

breaks the InBetween continuity. Other keyframes before or after it will have independent

inbetweens.

To learn more, go to "Keyframe Settings" in "Commands & Tools".

E-3. Keyframe Unset Button  
Sets a current keyframe back to a normal frame.

E-4. About Keyframe Set/Unset
A single click will set (or unset) the keyframe in both X and Y values.

Shift-click will set (or unset) the keyframe only in the current mode.

In other words, to "set keyframe for X value only", use shift-click.
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F. Auto InBetween Mode Button  
If this button is ON, the stage will be in "Auto InBetween Mode".

To learn more about "Auto InBetween Mode", go to "Auto InBetween" in "Commands &

Tools".

G. Display Mode Select Button  

G-1. Basic View

When selected, the current frame displays in color wire frame on stage.

No other information is displayed.

G-2. Image  

When turned on, all layer images are shown on stage.

Note:

In sheet nesting mode, the nested sheet does not display any image.
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G-3. Outline  

When turned on, characters are shown in outlines.

G-1 to G-3 display modes cannot be turned on at the same time.

G-4. All Keyframes  
-> Position X, Y

-> Position Z

-> Scale

-> Rotation

-> Center

When turned on, all keyframes of the current pegbar/layer are shown on stage.

G-5. All Frames  
When turned on, all frames of the current pegbar/layer are shown on stage.

G-4 and G-5 cannot be turned on at the same time.

G-6. Frame Path  
When turned on, the path of the current pegbar/layer is shown on stage.

This frame path represents the center point path of the current pegbar/layer.
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G-7. Show Pegbar  
When it is on, the tab marker of the current pegbar/layer is shown on stage to indicates

its top-bottom orientation.

[Pegbar OFF] [Pegbar ON]

H. Data Input Area

The current pegbar or layer's position (X, Y, Z), scale (X, Y), rotation and center

parameters can be input numerically in these boxes.

To input, click a box to highlight it, type a value, then press the Enter key.

Press Tab to move to the next field. Shift-Tab to move back to the previous field.

The box to the left of the input field is the Keyframe Box.

A keyframe box cannot be selected directly.

To select a keyframe, click its data input field to its right, and use Keyframe Set Button.
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  I. Frame Control Panel

      

Controls the current frame.

The frame number of the current frame is indicated here.

Click to enter another frame number, and press the Enter key.

If "64" is entered, it moves to frame 64.

If "5+10" is entered, it moves to 5 second 10 frame (when in "Seconds + Frames"

mode).

To the first frame

To previous frame

To next frame

To the last frame

Play

Stop

  J. Frame Slider

Continuously controls the current frame.

Drag the slider to move to any desired frame.

Drag the slider to the far left to move to the first frame.

Drag the slider to the far right to move to the last frame.
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  K. Stage Area

Displays pegbars and layers.

Layers (images) are shown in colored rectangle wire frames.

To change the color of the wire frame, click the "Color Select Box".

K-1. "Pegbar" Selected
All layers linked to the same pegbar are shown in same frame color.

All layers linked to the current pegbar are shown in bold frames.

Other layers not linked to the current pegbar are shown in dimmed frames.

K-2. "Layer" Selected
All layers linked to the same pegbar are shown in same frame color.

The current layer is shown in bold frame.

Other layers are shown dimmed.

The center of the camera/cel is a "+" mark.
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 L. Hand Scroll
Control-drag to scroll the stage display area.
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Z View Window

CoreRETAS version 5 has added a Z value (P Position Z).

The Z value can only be controlled in "Pegbar" mode. "Layer" does not have a Z value.

When creating a new x-sheet, the camera pegbar's Z value is set to "500" by default,

other pegbars are set to "0".

To change a layer's Z depth, link it to a pegbar first.

The stacking order at layers linked to the same frame is determined by the x-sheet.

The stacking order of pegbars with the same Z value is determined by the layer's

stacking order.

If a pegbar's Z value is larger than that of the camera, it will not be rendered.

Sample:

================================================================================

Layer [    A    ] [    B    ] [    C    ] [    D    ]

Pegbar [   #01   ] [   #02   ] [   #01   ] [   #02   ]

P Position Z [   0.00  ] [   0.00  ] [   0.00  ] [   0.00  ]

<- Lower Upper ->

Order [    A    ] [    B    ] [    C    ] [    D    ]
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Now change pegbar #02's Z value to "1.00".

--------------------------------------------------------------------------

Layer [    A    ] [    B    ] [    C    ] [    D    ]

Pegbar [   #01   ] [   #02   ] [   #01   ] [   #02   ]

P Position Z [   0.00  ] [   1.00  ] [   0.00  ] [   1.00  ]

<- Lower Upper ->

Order [    A    ] [    C    ] [    B    ] [    D    ]

================================================================================

Furthermore, the Z value might not be the only element determining the order.

If the other two pegbars' Z values are set to "0.00" & "1.00", it will have the same result

if the Z values were set to "0.00" & "5.00".

Sample:

================================================================================

Layer [    A    ] [    B    ]

Pegbar [   #01   ] [   #02   ]

P Position Z [   0.00  ] [   1.00  ]

<- Lower Upper ->

Order [    A    ] [    B    ]

Now change pegbar #02's Z value to "5.00".

--------------------------------------------------------------------------

Layer [    A    ] [    B    ]

Pegbar [   #01   ] [   #02   ]

P Position Z [   0.00  ] [   5.00  ]

<- Lower Upper ->

Order [    A    ] [    B    ]

================================================================================
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Rendering Window

Displays the current frames' rendered result. Also displays the rendering process on

"Export..." or "Batch Export".

Click inside the window to zoom in. Alt/Opt-click to zoom out. Control-drag to scroll the

image.

A. Render Button  
Renders the current frame.

Same as "Render Current Frame" command.

B. RGB View Button  
Displays RGB image.
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C. Alpha View Button  
Displays the Alpha channel.

Note: In the BG layer, Alpha channel is usually displayed in white because the entire

camera has been covered by the background.

D. Zoom In Button  
Enlarges the image.

E. Zoom Out Button  
Reduces the image.

F. Normal Size Button  
Returns to normal size.

G. Save Image Button  
Saves the current image to disk.

Click this button to bring up the Save dialogue and choose a destination.

H. Capture Button  
Captures the current image and copies it into Clipboard.

Same as "Copy" command.

Use this to copy and paste the image to other applications.

I. DDR Button  
Sends the current image to a DDR as one frame.

Use this to confirm the image color on a video monitor.
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J. Information Display Area
Displays pixel information that the cursor points to.

R, G, B : RGB value of the pixel under the cursor.

A : Alpha value of the pixel under the cursor.

X, Y : X, Y coordinates of the pixel under the cursor.

K. Image Display Area

Displays a rendered image.
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CelBank

A palette that imports images for layers, and displays image thumbnails.

To show/hide it, choose "CelBank" under "Window" menu.

A. CelBank Select Button  
Click the celbank layer name popup menu to select a celbank layer.

Alternately click the left or the right arrow to switch layers.

The difference from CoreRETAS version 4: if you change a celbank layer, the x-sheet

layer does not follow.

Similarly, the layer in the "Stage Window" or "Layer Setup Palette" does not follow.

A-1. Current CelBank
A currently selected celbank is called "Current CelBank".

B. Reload Button  
Refreshes the images already imported into a celbank.

While using CoreRETAS, you can launch PaintMan to modify some images, and then

press this button to reload modified images.

C. Import Button  
Imports images into the current celbank.

In RETAS! PRO version 4, only one celbank can be used by one layer. If multiple

layers used the same cel, it had to be imported to multiple celbanks.

RETAS! PRO ∞ allows multiple layers to share one celbank.
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Cel import dialogue:

C-1. Cancel
Cancels the import and closes the dialogue.

C-2. Open
Imports all images in the same folder into the celbank.

C-3. Select One
Imports only one selected image into the celbank.

C-4. Create/Update  
Creates or updates the image preview.

C-5. Preview   /Show Preview  
Shows or hides the preview.

C-6. Image Format Popup Menu
Selects the file format for import.

The file list only displays files of the selected format.

For a list of compatible formats, go to "Appendix".

CelBank can also import x-sheets, instead of images.

Importing an x-sheet into the celbank is called "Nesting", and is used for complicated camera

work compositing.

To learn more about Nesting, go to "Nesting" in "Commands & Tools".



112

Chapter 6-2    Windows & Palettes

C-7. All Image Type
Images created on other platforms may not appear in the Open dialogue. In this case,

choose "All Image Format" to see all files.

In order for this to work correctly, file extension must be present.

D. Delete Button  
Deletes the images in the current celbank.

E. Thumbnail Display Area

Displays the thumbnails of the images already imported to the celbank. The cel

Number is indicated under each thumbnail.

The Cel Number is unrelated to the original file name, and only indicates its order inside

a folder.

Click a thumbnail to select it. A selected thumbnail is surrounded by a red frame, and

the information is displayed.

F. File Name Display Area  
Displays a selected file's name.

G. Image Size Display Area  
Displays a selected image's size. (Unit: pixel)

H. Resolution Display Area  
Displays a selected image's resolution. (Unit: DPI)

I. File Path Display Area  
Displays a selected file's path.
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J.  Total Cels Number Display Area  
Displays the total number of cels in the current celbank.

K. View Switch Button  
Click to collapse the celbank window. Thumbnail Display Area will hide.

Click again to expand the celbank window back to normal view.
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Layer Setup

Layer Setup Palette displays layer preview and configures layer mode.

A. Layer Select Button  
Click the layer name popup menu to select a layer to edit.

Alternately click the left or the right arrow to switch layers.

B. Preview/Setup Switch Tab  
Switches between "Preview" and "Setup".

To preview a layer, select the "Preview" tab.

To configure the layer mode, select the "Setup" tab.

B-1. Preview

Confirms a layer's animation settings.

If a soundtrack is imported into the sound layer, the sound can be checked as well.
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B-2. Frame Control Panel

To next frame

To previous frame

Play

If a soundtrack is imported in the sound layer, the sound is played as well.

Stop

Refresh layer preview memory

Use this in the following cases:

• Sheet timing has changed

• Layer images have changed

B-3. Display Select Button

Selects a layer to be previewed.

Select "Main" to preview the "Cel Layer".

Select "Upper" to preview the "Upper Sub-cel" layer.

Select "Lower" to preview the "Lower Sub-cel" layer.
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B-4. Preview Area

Displays the preview image.

B-5. Frame Number

Displays the frame number.

C. Setup
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C-1. Compositing Mode Menu

Configures a layer's compositing mode.

Available compositing modes:

Normal

Add

Lighter

Darker

Subtract

Difference

Multiply

Screen

Backlight

Gray Mask

Alpha Mask

To learn more about compositing modes, go to "Composite Modes" in "Commands &

Tools".

A compositing mode cannot be used between a sub-cel layer and its main cel layer.
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C-3. Mask Mode Menu

Configures a layer's transparency mask type.

Available masks:

  White Transparent
The white (RGB = 255, 255, 255) portion becomes transparent.

Mainly used with mono-traced images.

  Alpha Channel
The transparent portion is determined by Alpha channel.

(White = opaque. Black = transparent)

Used with gray-traced images, overlays, 3D images.

  Alpha Channel (Invert)
The transparent portion is determined by Alpha channel.

(White = transparent. Black = opaque)

Used with gray-traced images, overlays, 3D images.

  Opaque
Primarily used with backgrounds.

C-4. Smoothing  
Applies smoothing (antialiasing) to a layer when it is turned on.

C-5. Tiling  
Repeats an image in X or Y direction when it is turned on.

Used for creating a pattern.
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Status Palette    

Displays the progress of celbank import, effects processing and other functions that

may take some time.

The upper part displays the name of the function, and the lower part displays a

progress bar.

[Figure: Displaying focus progress]
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Menu Bar Commands
File Menu
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New X-sheet...
Creates a new exposure sheet.

CoreRETAS version 5 can open multiple sheets simultaneously.

An version 4 x-sheet saved by version 5 cannot be read again by version 4.

A. X-sheet Name

Enter a name for the x-sheet.

RETAS! PRO version 5 adds a file extension by default even it is on Mac OS.

Unless necessary, do not delete the extension.

B. Frame

From 4 to 6000 frames.
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C. Layers

From 1 to 100 layers.

D. Camera Width/Height

Minimum size is 60 x 60 pixels.

Maximum size is 8000 x 8000 pixels.

E. Camera Size Template Menu

Select a standard camera size from this popup menu.
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F. Units

Select the units for CoreRETAS.

"pixel": position information in x-sheet will be shown in pixels.

"mm": position information in x-sheet will be shown in millimeters.

"inch": position information in x-sheet will be shown in inches.

These settings can be changed any time after the sheet is created by choosing "Sheet -

> Sheet Settings -> General" command.

G. Standard Resolution

Standard resolution for a 100Frame. (Units: DPI)

CoreRETAS calculates mm (or inches) per pixel based on the camera size and

standard resolution.

To learn more about standard resolution, go to "Standard Resolution" in "Technical

Information".

H. FPS

Frames per second.

When exporting to a QuickTime or AVI movie, playback speed is based on this setting.

I. Sheet View

Select a sheet view mode.

Seconds + Frames
Displays seconds and frames.
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Feet
Displays in feet.

Frame Number
Displays frame number order.

Page + Frame + Number
Displays page number and frame number.

Maximum number of frames per page is set by "Frames Per Page".

J. Frames Per Page

Maximum number of frames per page

K. Guide Line

For easier viewing, guide lines can be added.

Enter "6" for a guide line every 6 frames.

L. Cancel

Cancels the settings and closes the dialogue without creating a new x-sheet.

M. OK

Click to create a new x-sheet.
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Open...
Opens an x-sheet (file extension: tsf) previously saved on a disk.

      

Note: X-sheets created by version 4 can be read, but the "Link Layer" information will

be lost.

Open Scene Folder...
Opens a scene folder previously saved on a disk.

The following dialogue appears:

Select a scene folder and click "Select".

Note:

If multiple x-sheets exist in the scene folder, CoreRETAS opens the first x-sheet found.

If you want to open other x-sheets in this folder, use "Open..." command.

To learn more about scene folder, go to "Reading A Scene Folder" in "Commands &

Tools".
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Close
Closes the active window.

The save dialogue may appear if the x-sheet is not saved.

Save
Saves the active x-sheet.

It will overwrite the x-sheet with the same name inside a folder.

The save dialogue may appear if it is a new x-sheet.
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Save As...  
Saves the active x-sheet with another name.

The save dialogue appears asking for a name and save destination.

Revert
Reverts the x-sheet to its last saved version. If you made mistakes, use this to cancel

all changes.
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Save Image...
Saves the image in the rendering window as a file.

The save dialogue appears asking for a name and save destination.

Note: Saving in 32 bit format is recommended.



130

Chapter 6-3 Menu Bar

Export...
Exports the x-sheet to DDR and/or HDD.

The "Export" dialogue appears.

A. File Export
Exports to HDD if turned on.

A-1. File Type

Select an export file type.
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A-2. File Setup...

File type options.

A-3. Setup...

Export options, regardless of file type.

[Figure: Still image options]

• No Multiple Frame Copies

Frames containing the same image will not be exported when turned on.

• Create Preview Icon

Creates a preview icon for each file when turned on.

• Add File Extension

Adds a file extension if when turned on.

Unless there is a specific need, always turn this on.
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• Starting File Number

Starting frame number is added to the first frame.

Default is 1.

Unless necessary, it is recommended that you do not change it.

• Export Sound

If a sound has been imported in the sound layer, it can be exported with a movie file.

[Figure: QuickTime movie option selected]

A-4. Save Location 1
• Select...

Click to select a destination to save the files.

• Folder Path Display Area

Displays the folder path where the files will be saved.
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Note:

If no destination is selected for "Save Location 1", the "OK" button of Export dialogue

will be dimmed.

If the "DDR Export" check box is turned on, the "OK" button will be on even if no

destination is selected for "Save Location 1"

In this case, files are exported to DDR only, not to HDD.

A-5. Save Location 2 ~ 4
Same as "Save Location 1".

If "Location 1" disk is full, CoreRETAS automatically writes to "Location 2", or

subsequent disks.

A-6. Size

• Current

Exports in the current camera size.

• 1/2

Reduces to 1/2 size.

• W/H

Enter any value in width /height for a customized size.

Standard sizes can be selected from the popup menu.

B. DDR export

Exports images to DDR if it is turned on.

B-1. Record In-Point

• H : M : S : F

Enter time code in hours, minutes, seconds and frames as the recording start point.

• Sheet Settings

Follows the "Sheet Settings -> In-Point" in an x-sheet.
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B-2. DDR Control Button

Controls a DDR if connected.

To preview frame

Brings up the time code input dialogue

Enter the time code setting you wish to jump to.

To next frame

B-3. Still Frames

• Starting

Repeats the first frame at the start.

• Ending

Repeats the last frame at the end.

Used for creating still images at the start and end of a scene.

C. Range

Selects the export range

"Range" controls both "File Export" and "DDR Export".

C-1. All Frames
All frames in the x-sheet will be exported.

C-2. Range
Only a selected range will be exported.

• ? to ?

Enter starting and ending frame numbers.

Only indicated portion will be exported.
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• Every ? Frames

   Skips a specified number of frames.

   "Every 1 Frames" exports all frames without skipping.

   "Every 3 Frames" skips 2 frames out of every 3 frames.

   Use this option to reduce rendering time when previewing camera work.

   Difference from CoreRETAS version 4: even if this option is used on QuickTime

movie export, camera work can still be checked with the correct timing as configured in

the x-sheet.

D. Export Sheet Info

"Sheet Settings -> Info" contents will be exported as still frames before actual

rendering.

E. Show Rendering Settings Dialogue

Brings up "Rendering Settings" dialogue before starting.
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Batch Export...
Exports multiple x-sheets saved on a disk.

Choose "Batch Export..." under "File" menu. The following dialogue appears:

A. File Select List (Left)

Select x-sheets to be exported.
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B. Batch Export List (Right)

A list of x-sheets to be exported.

C. "Add" Button  
Select an x-sheet in "File Select List", then click "Add" to add it to the "Batch Export

List".

Alternately, double-click an x-sheet icon in "File Select List" to add.

D. "Add All" Button  
Click "Add All" to add all x-sheets found in the "File Select List" to the "Batch Export

List".

E. "Delete" Button  
To delete an x-sheet in the "Batch Export List", select it first, then click the "Delete"

button.

Alternately, double-click an x-sheet in the "Batch Export List" to delete it.

F. "Export" Button  
Click "Export" if "Batch Export List" is completed. The "Export" dialogue appears.

To learn about the "Export" dialogue, go to the "Export..." command explanations.
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DDR
-> Control

  

  [Figure: DDR Control Dialogue (Sample: Accom WSD)]

Controls a digital disk recorder (DDR) if connected.

Reverse playback 10x speed

Reverse playback 2x speed

Reverse playback 1x speed

Reverse

Stop

Forward

Forward playback 1x speed

Forward playback 2x speed

Forward playback 10x speed

Enter a frame to jump to

Sample: 01:20:01 1 minute 20 seconds 1 frame

14:06 14 seconds 06 frames

9204 9204 frames
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-> Setup...
Choose "DDR Setup...", and the following dialogue appears:

Depending on the type of DDR connected, the dialogue contents may differ.

[Figure: DDR Setup Dialogue (Sample: Accom WSD)]

A. Interface
Select whether it is connected via SCSI or Ethernet.

B. Size
Select NTSC or PAL depending on your needs.

C. IP Address
Configure an IP Address if connected via Ethernet.

D. Advanced Setup...
DDR control additional options.

Note: It is recommended that the default settings not  be changed only if necessary.

To learn more about the settings, consult your DDR documentation.
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Quit
Quits CoreRETAS.

The save dialogue may appear if x-sheet is not saved.
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Edit Menu

Undo
Cancels last change and returns the x-sheet to its previous state.

Note: does not apply to all operations.

Cut
Cuts off selected data in the x-sheet and stores it in the clipboard.

Copy
Copies selected data and stores it in the clipboard.

Difference from "Cut": does not remove data.

Paste
Pastes the data stored in the clipboard into a selection.

"Cut" & "Copy" will copy all parameters from a layer (and linked pegbar) to clipboard.

"Paste" will overwrite all parameters in a layer (and linked pegbar).

To learn more, go to "About Cut & Paste" in "Technical Information".
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Selective Paste...
Pastes only selected parameters.

Choose "Selective Paste...", the following dialogue appears:

Select the check box of the desired parameter(s), then click "OK".

Insert & Paste
Inserts a frame and pastes the data.

Clear
Erases the contents of a selection and does not store data in clipboard.
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Select All
Selects all data cels.

This function varies depending on the current existing selection.

A. Current Selection In "Camera Layer"
Selects all frames (all data cels) in the camera layer.

B. Current Selection In "Cel Layer"
Selects all frames (all data cels) in all cel layers.

Sub-cel layers are excluded.

C. Current Selection In "Sub-cel Layer"
Selects all frames (all data cels) in the current sub-cel layer.

D. Current Selection In "Effect Layer"
Selects all frames (all data cels) in the current effects layer.

Select Copied Range
Selects the same range stored in the clipboard.

The range starts from the first (upper left) data cel selected.

The first data cel selected is the only one not highlighted within a selection.
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Preferences...
CoreRETAS preferences settings.

A. Preferences Setting Options Menu
6 options are available:

• General

• Export

• File

• X-sheet

• Stage

• DDR

Click the left or right arrow to switch between the options.  
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A-1. General

Click "Select..." button to select a plug-in folder.

Unless necessary, do not change the default plug-in folder.

If the plug-in folder location is changed, it will not reload until the next time you launch

the application.
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A-2. Export

• Reverse Field On 3:2 Pulldown Change

Even and odd field will be reversed when the 3:2 pulldown change function (Change

3:2 Pulldown 24 -> 30) inserts fields on export.

3:2 pulldown change function adds frames by inserting fields. The fields will be

reversed when writing to DDR, which may cause image shift.

If this is the case, check this option.

• File Number Digit

   Configures how many digits will be used in the file number.

   Default setting is 4 digits.

• Export Completion Sound

Off

   No chime sound when export is complete.

Standard Sound

   Uses CoreRETAS standard chime sound when export is complete.

External Sound

   Uses a user-selected sound when export is complete.

   The compatible sound format is "wav".

Click "Play" to confirm the sound.

Click "Select" to choose a sound file.
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A-3. File

• Load Thumbnails In CelBank

   Loads thumbnails when importing images into a celbank.

• Create & Save Thumbnails

If thumbnails do not exist when importing images into a celbank, this option will

automatically create and save them.

• Create Thumbnails From Movie File

This option will automatically create thumbnails when importing a movie into a

celbank.

• Save Outline

Saves outline data when choosing "Outline" mode on stage.

The second time you choose "Outline" mode on stage, the playback speed becomes

much faster.
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A-4. X-sheet

• Paste With Keyframes

Keyframes will also be pasted when pasting parameters when this is turned on.

• Adjust Position In Center Mode

When activated, if you change a "pegbar center" or "layer center", the image does

not move - position is adjusted according to the center change.

When off, if you change a "pegbar center" or "layer center", the image moves -

position not adjusted according to the center change.

Default setting is "ON".
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A-5. Stage

• Size (W, H)

Stage size settings.

• Center (X, Y)

Stage center's coordinates.

"Stage Center" is the upper left point.

(It is unrelated to "pegbar center" or "layer center".)

• Render Special Effects On Stage

Renders special effects on the stage if "Image" mode is selected.

This sometimes requires a long time. If confirming special effects on stage is not

really necessary, turn this off.

• Stage BG Color

Click the color box to choose a background color for the stage.
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A-6. DDR

• Machine

Select the disk recorder (DDR) type connected to your computer.
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Sheet Menu
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Parameter Settings...
Settings of various parameters for a pegbar and layer.

A. Pegbar
Enter pegbar parameters and set keyframes.

A-1. Parameter Check Box  

Turn on the check box and enter designed parameters.

A-2. Keyframe Area
Sets a keyframe.

Click to toggle between "Continuous Keyframe" -> "Continuous Keyframe" ->

"Keyframe Off".

The keyframe area in an x-sheet cannot be selected.

A-3. Parameter Area  
Enter the desired parameter here.



Chapter 6-3 Menu Bar

153

A-4. Position Information Select Menu

• Absolute

   Inputs the entered parameters into the x-sheet as absolute values.

• Relative

Adds the entered parameters to the current values in x-sheet.

Negative values are OK.

• Scale Relative

Adds the entered parameters into the current values in the x-sheet depending on the frame's

scaling. If a cel size is enlarged, the added value will be greater by the same amount. If a cel

size is reduced, added value will be smaller by the same amount.

B. Layer

Settings are same as Pegbar.

If no cel number is registered in the x-sheet, "Layer" settings cannot be used.

C. Others

Enter a desired value in "Transparency" or "Motion Blur".
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Cel Number Auto Input...
Automatically input cel numbers into a selection.

A. From
Starting cel number.

B. To
Ending cel number.

C. Number Skip
If set to 0, no cel number will be skipped.

D. Frame Skip
If set to 0, no frame will be skipped.

E. Every ? Frames
Number of frames to be repeated.

F. Repeat ? Times
Number of times to be repeated.

Click "OK" to input the cel numbers into a selection.
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Sample 1:
From 11

Number Skip 00

To 55

Frame Skip 00

Every 22 Frames

Repeat 11 Times
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Sample 2:
From 11

Number Skip 00

To 55

Frame Skip 00

Every 22 Frames

Repeat 22 Times
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Sample 3:
From 11

Number Skip 11

To 55

Frame Skip 00

Every 22 Frames

Repeat 22 Times
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Sample 4:
From 11

Number Skip 00

To 55

Frame Skip 22

Every 11 Frames

Repeat 22 Times
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Cel Auto Arrange
Uses the frame number found in a file name and automatically arranges it when

copying from celbank to x-sheet.

If you have files exported by CoreRETAS, you can re-import them by using this

convenient feature.

This feature requires a frame number attached to a file name.

Sample: A00001.TGA Automatically arranges at frame 1

A00015.TGA Automatically arranges at frame 15

A00024.TGA Automatically arranges at frame 24

CoreRETAS searches for a number in the right of a file name (extension excluded) and

uses this number as the frame number.

Sample: ABC001.TGA Automatically arranges at frame 1

12A064.TGA Automatically arranges at frame 64

A1-038.TGA Automatically arranges at frame 38

If the "No Multiple Frame Copies" option is check upon export, files can still be

arranged upon re-import.

As long as your files contain frame numbers in the name, they can always be

automatically arranged even if not created by RETAS! PRO version 5.
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Frame
-> Insert...

Insert frames into the x-sheet.

The following dialogue appears.

  A. Insert ? Frames
Enter the number of frames to be inserted.

  B. Before/After Current Frame
Select one of these options.

Total number of frames in the x-sheet is also increased.

Parameters in newly inserted frames are reset to default.

-> Delete...
Deletes frames.

"Frame Delete" dialogue appears. Enter a number of frames to be deleted.

Click "OK" to delete the selected frames starting from the current frame.
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After deletion, the equivalent number of frames at the end of x-sheet become empty.

Parameters in these empty frames are reset to default.
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Layer

-> Insert...

Inserts a layer into the x-sheet.

The following dialogue appears.

Enter a layer name and click "OK".

The last available pegbar is linked to the inserted layer by default.

The last available celbank is linked to the inserted layer by default.

-> Delete
Click a layer title bar to select it then choose this command to delete it.

The camera layer cannot be deleted.

-> Rename...
Renames a new layer.

The following dialogue appears.

Enter a name no longer than 10 characters.

Click "OK" to rename.
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Pegbar
-> Insert...

Inserts a new pegbar.

The following dialogue appears.

The newly inserted pegbar is not linked to any layer.

  A. New Pegbar Name
Enter a name for the new pegbar.

  B. Before/After Current Pegbar
Choose a location, either before or after the current pegbar.

  C. Pegbar Frame Color
Choose a frame color for the new pegbar.

Click the color box and select a color from the Color Picker.

-> Delete
Deletes the current pegbar.

If a layer is linked to the pegbar, a dialogue may appear for confirmation.

Click "OK" to delete the pegbar.

The linked layer automatically reconnects itself to the last available pegbar.

It is recommended that you always disconnect all linked layers before deleting a

pegbar.
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-> Rename...
Renames the current pegbar.

The following dialogue appears.

Enter a name no longer than 10 characters.

Click "OK" to rename the pegbar.
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CelBank
-> Insert...

Inserts a new celbank.

The following dialogue appears.

The newly inserted celbank is not linked to any layer.

  A. New CelBank Name
Enter a name for the new celbank.

  B. Before/After Current CelBank
Select a location, either before or after the current celbank.

-> Delete
Deletes the current celbank.

If a layer is linked to the celbank, a dialogue may appear for confirmation.

Click "OK" to delete the celbank.

The linked layer automatically reconnects itself to the last available celbank.

It is recommended that you always disconnect all linked layers before deleting a

celbank.
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-> Rename...
Renames the current celbank.

The following dialogue appears.

Enter a name no longer than 10 characters.

Click "OK" to rename the celbank.



Chapter 6-3 Menu Bar

167

Sound
-> Import...

Imports a sound file into the sound layer.

A sound file must be in AIFF or WAV format.

-> Delete
Deletes an imported sound file from the sound layer.

-> Play

Plays the sound file in the sound layer.

To play a portion of the sound, make a frame selection in the x-sheet first then choose

this command.

(Note : RenderDog can only play all frames.)

-> Stop
Stops sound playback.

-> Info...
Displays the sound file information:

• File name

• File location

• Play time

• Format
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Set Continuous-Keyframe
Sets a selected frame in x-sheet as a continuous-keyframe.

The difference from "Continuous-Keyframe Set Button" on the Stage: multiple

keyframes can be set at one time.

"X only" or "Y only" keyframe settings cannot be done in the x-sheet.

If you wish to do so, use "Continuous-keyframe Set Button" on the Stage.

To learn more about "Continuous-Keyframe", go to "Keyframe Settings" in "Commands

& Tools".

Set Noncontinuous-Keyframe
Sets a selected frame in x-sheet as a noncontinuous-keyframe.

The difference from "Noncontinuous-Keyframe Set Button" on the Stage: multiple

keyframes can be set at one time.

"X only" or "Y only" keyframe settings cannot be done in the x-sheet.

If you wish to do so, use "Noncontinuous-keyframe Set Button" on the Stage.

To learn more about "Noncontinuous-Keyframe", go to "Keyframe Settings" in

"Commands & Tools".
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Unset
Unsets a keyframe in x-sheet.

The difference from "Keyframe Unset Button" on the Stage: multiple keyframes can be

unset at one time.

"X only" or "Y only" keyframe unset cannot be done in the x-sheet.

If you wish to do so, use "keyframe Unset Button" on the Stage.



170

Chapter 6-3 Menu Bar

InBetween

-> Apply

Inbetweens frames according to the settings.

1. Select a frame range for inbetweening.

2. Choose "InBetween -> Apply".

The Inbetween command applies when at least 2 keyframes are selected.

[Figure: First and last frames are keyframes]

[Figure: No keyframes selected]
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[Figure: Keyframes included within a selection]

X, Y and Z values will be inbetweened.

If you want only one parameter to be inbetweened such as "X only" or Y only", choose

"InBetween -> Current Parameter Only".



172

Chapter 6-3 Menu Bar

-> Setup... [Ctrl+Y]
Brings up InBetween Setup dialogue.

To learn more about InBetween settings, go to "About InBetween" in "Technical

Information".

Follow Setup...
Configures individual frame move distance and angle of camera or cel.

Select a frame range in the x-sheet, regardless of the input mode of the x-sheet.

"Follow Setup" target is "P Position X" and "P Position Y".

"Follow" is unrelated to rotation. To set up a rotation, use "T Rotation" mode.

The following dialogue appears.
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A. Distance
Enter a individual frame move distance.

A negative value is OK.

Units can be configured in "Sheet Settings -> General".

The movement starts from the first frame in a selection.

B. Angle
Enter an angle for move direction (up to 3 decimals).

Angle starts from 0° in a clockwise direction.

  0° Right

  90° Down

  180° Left

  270° Up

To move to lower-right 10°, set the angle to 10°.

To move to upper-right 10°, set the angle to 350°.

C. In Frames
Number of frames for acceleration at the start.

D. Out Frames
Number of frames for deceleration at the end.
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Random Input...
Inputs irregular parameters into a selection.

The following dialogue appears.

A. Plus/Minus Range
Enter a number for maximum range.

Sample 1 : Plus Range = 10

  Minus Range = 10

The parameter randomly changes between "10" ~ "-10".

Sample 2 : Plus Range = 5

  Minus Range = 1

The parameter randomly changes between "5" ~ "-1".

Values at the "Start" and "End" can be configured separately.

To set up camera work such as "shake decreases" or "shake increases", use this

feature.

Sample 3: Start End

Plus Range = 10 Plus Range = 0

Minus Range = 10 Minus Range = 0

The parameter randomly changes between "10" ~ "-10 at the beginning, then down to

"0".
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B. Relative Value
The parameter will be added to an existing one if it is turned on.

If turned off, the new parameter will replace an existing one.

C. Plus/Minus Value Alternation
The Plus and the Minus value will be randomized.

D. Integer Only
No decimals.

E. Same Value For Same Cel.
The same cel number uses a same value.

Calculation...
Performs a calculation on an existing value.

The following dialogue appears.

Enter a value, up to 3 decimals, and choose a mode among Multiply, Divide, Add, and

Subtract.

  Multiply existing value x entered value = new value

  Divide existing value ÷ entered value = new value

  Add existing value + entered value = new value

  Subtract existing value - entered value = new value
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Reverse
Reverses the parameters within a selection in descending order.

Keyframes will be reversed as well.

First Frame
Goes to the first frame.

Last Frame
Goes to the last frame.

Jump To Frame...
The following dialogue appears.

Enter a frame number and click "OK" to jump to that frame.

"5+10" can also be entered if the "Sheet View" is changed to "Second + Frame" mode.

Sample: 2+5 2 seconds 5 frames

5+10 5 seconds 10 frames
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Current Frame
If the current frame is not visible, choose this command to bring it up.

[Figure: Current frame not visible -> bring to center]
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Collapse Sheet
Closes "sub-cel layer", "effects layer" and "sound layer".

Expand Sheet
Opens "sub-cel layer", "effects layer" and "sound layer".
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Sheet Settings...
Configures various settings of the x-sheet.

-> General...
General settings.

A. X-sheet Name
For confirmation only, cannot be modified.

B. Frames
Length (total time) of an x-sheet.

If you increase the number of frames, new frames will be added to the end of the x-

sheet.

Parameters in the newly added frames are set to default.

If you decrease the number of frames, frames will be deleted from the end of the x-

sheet.

C. Layers
Total number of layers in an x-sheet.

Camera layer is excluded.
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If you enter "4", there will be 4 layers: "-BG", "A", "B" and "C" plus the camera layer.

If you increase the number of layers, new layers will be added to the right of the x-

sheet.

Parameters in the newly added layers are set to default.

If you decrease the number of layers, layers will be deleted from the left of the x-sheet.

D. Camera Width/Height
Enter a camera size here.

E. Camera Size Template Popup Menu
Select a standard camera size here.

F. Units
Select the units to be used by CoreRETAS.

G. Standard Resolution
Standard resolution for a 100Frame. (Units: DPI)

CoreRETAS calculates mm (or inches) per pixel based on the camera size and

standard resolution.

To learn more about standard resolution, go to "Standard Resolution" in "Technical

Information".

H. FPS
Frames per second.

When exporting to a QuickTime or AVI movie, movie playback speed is based on this

setting.

I. Sheet View
Select a sheet view mode.

• Seconds + Frames

   Displays in seconds and frames.

• Feet

   Displays in feet.
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•Frame Number

   Displays in frame number order.

•Page + Frame + Number

   Displays in page number and frame number.

Maximum number of frames per page is set by "Frames Per Page".

J. Frames Per Page
Maximum number of frames per page

K. Guide Line
For clearer sheet view, guide lines can be added.

Enter "6" to have a guide line every 6 frames.

L. Cancel
Cancels the above settings and closes the dialogue.

M. OK
Click to accept the changes.
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-> Information...

Stores sheet information such as title, episode number, ... etc. This information can be

exported during recording by turning on the "Export Sheet Info" option.

This information cannot be displayed in an x-sheet and is for recording purpose only.

A. Title
Enter a title.

Previously entered titles can be selected from the popup menu on the right.

A maximum of 10 titles can be stored in this menu.

B. Episode
Enter an episode number.

Previously entered episode numbers can be selected from the popup menu on the

right.

A maximum of 10 episode numbers can be stored in this menu.

C. Sequence
Enter a sequence number.

D. Scene
Enter a scene number.
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E. Seconds
Enter the scene duration in seconds.

F. Frames
Enter the total number of frames.

G. Take
Enter the take number.

H. Memo
Enter a memo.

A short note for communication with others.

Previously entered memos can be selected from the popup menu on the right.

A maximum of 10 memos  can be stored in this menu.
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-> Memo...

An x-sheet memo.

This "Memo" will pop up if you double-click an x-sheet or choose "Open" under "File"

menu.

For sending work note to others, such as a note on camera work.
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-> In-Point...

Recording start point when exporting to DDR (digital disk recorder).

Enter a time code in "Hours : Minutes : Seconds : Frames".

This In-Point is used for "Export -> DDR Export -> Record In-Point -> Sheet Settings".

If a new In-Point is configured in "Export" dialogue, this In-Point will be ignored.
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Stage Menu

Image display mode settings in the "Stage Area".

Same as "Display Mode Select Button" in the stage window.

This menu is dimmed if no stage window is present.
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Basic View
When selected, a current frame displays in color wire frame on stage. No other

information is displayed.

      

Although image contents can also be viewed, this mode allows higher speed playback

for position confirmation.
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Image
All layer images are shown on stage.

[Figure: "Image" mode]
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Outline
Elements are shown in outlines.

[Figure: "Outline" mode]
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All Keyframes
All keyframes in the current pegbar or layer are shown on stage.

Select from one of the following sub-commands to view keyframes only:

   -> Position X, Y

   -> Position Z

   -> Scale

   -> Rotation

   -> Center

[Figure: "All Keyframes" mode]
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All Frames
All frames of the current pegbar/layer are shown on stage.

[Figure: "All Frames" mode]
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Frame Path
The path of the current pegbar/layer is shown on stage.

This frame path represents the center point path of the current pegbar/layer.

[Figure: "Frame Path" mode]
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Show Pegbar
The tab marker of the current pegbar/layer is shown on stage to indicates its

orientation.

[Pegbar OFF] [Pegbar ON]

Play
Animation playback on stage.

Playback speed depends on your computer processor speed, not the x-sheet setting

speed.

Stop
Stops the playback.

Zoom In
Enlarges the stage.

Zoom ratio is between 1/1 ~ 1/8.

Zoom Out
Reduces the stage.

Zoom ratio is between 1/1 ~ 1/8.
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Effects Menu

Controls an Effects Layer for adding special effects to a cel layer or the camera layer.

  An effects layer cannot be used separately with a sub-cel layer.

Add...
Adds an effects layer to a current layer.

To learn more about the effects layer, go to "About Effects Layers" in "Commands &

Tools".

Delete
Deletes an effects layer.

A confirmation dialogue will appear.

Another way to delete an effects layer is to drag an effects layer out of the x-sheet

window.

Setup...
Settings of an effects layer.

To learn about effects settings, please refer to each plug-in filter's guide.

Shift-click an effects layer's title bar also brings up the settings dialogue.
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Render Menu

Controls rendering and related settings.

Render Current Frame
Renders and displays the current frame in the rendering window.

[Figure: Rendering result]

Used for confirming a single frame.

Double-clicking a frame number in x-sheet also renders it.
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RGB View
Displays the RGB plane.

[Figure: RGB plane view]
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Alpha View
Displays the Alpha plane.

[Figure: Alpha plane view]

Note:

In the BG layer, the Alpha channel is usually displayed in white because the entire

camera has been covered by the background.
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Zoom In
Enlarges the image.

Zoom Out
Reduces the image.

Normal
Returns to normal size.

Capture To Clipboard
Captures the current image and copies it to the Clipboard.

Same as the "Copy" command.

Use this to copy and paste the image to other applications.

Send To DDR
Sends the current image to DDR as a single frame.

Use this to confirm the image colors on a video monitor.



Chapter 6-3 Menu Bar

199

Rendering Settings...
Configures rendering options.

The following dialogue appears.

A. Change 3:2 Pulldown 24->30
Converts 24 fps x-sheet to 30 fps movie by automatically inserting fields.

B. Rendering Window
Rendering quality settings.

B-1. Resolution
• Lowest

Lowest image quality, highest rendering speed.

Good for quickly confirming camera work.

• Low

Low image quality, high rendering speed.

• Mid

Medium quality.
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• Good

Standard quality by default.

Good enough for most purposes.

• Highest

Finest quality. But longest rendering time.

B-2. Threads  

Multi-threaded rendering.

For best performance, set the number of threads to the same as the number of CPUs

installed. For example, 1 thread for 1 CPU, 2 threads for 2 CPUs, and so on.

If you select 2 or 4 threads for a 1 CPU PC, rendering speed will not be increased.

Threads setting is only available for Windows NT.

C. Stage
Stage image rendering quality settings.

C-1. Quality
• Low

Lower image quality, higher rendering speed.

• Mid

Medium image quality.

• Good

Standard quality.

Good enough for most purposes.

C-2. Threads  

Multi-threaded rendering.

For best performance, set the number of threads to the same as the number of CPUs

installed. For example, 1 thread for 1 CPU, 2 threads for 2 CPUs, and so on.

If you select 2 or 4 threads for a 1 CPU PC, rendering speed will not be increased.

Threads setting is only available for Windows NT.
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D. Smoothing
Smoothing settings

D-1. Layer Settings
Follows the settings in the Layer Setup palette.

D-2. Auto
Automatically detects and applies smoothing for finer quality when cels are scaled.

D-3. All
Force smoothing on all layers.

"Layer Setup" settings are ignored.

D-4. Off
No smoothing for any layers.

"Layer Setup" settings are ignored.

E. Both Edge Smoothing
CoreRETAS version 5 renders all images in 32 bit with an Alpha channel.

Normally, the RGB plane is not smoothed on export.

If "Both Edge Smoothing" is turned on, RGB plane is smoothed on export.

If you don't need this option, leave it off.

E. BG Color
Sets a background color.

This "BG" is not the "-BG" layer but behind it, in monochrome.

Click the color box and choose a color from the Color Picker to change the background

color.
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Windows Menu

Shows or hides windows and floating palettes.

X-sheet
Brings an x-sheet to the front as the active one.

Stage
If the stage window is closed, opens it.

If the stage window is open but not active, makes it active.

If the stage window is open and active, closes it.

Z View
If the Z view window is closed, opens it.

If the Z view window is open but not active, makes it active.

If the Z view window is open and active, closes it.

Rendering Window
If the rendering window is closed, opens it.

If the rendering window is open but not active, makes it active.

If the rendering window is open and active, closes it.
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CelBank
If the celbank is closed, opens it.

If the celbank is open, closes it.

Layer Setup
If the layer setup palette is closed, opens it.

If the layer setup palette is open, closes it.
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Help Menu  

A. Version Info

View the current CoreRETAS version information.

This information will be required if you need to call technical support.

B. RETAS! PRO Home Page

Goes to the RETAS! PRO home page if you have internet access.

View the latest information and download updates from the home page.
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Help Menu

A. RETAS! PRO Home Page
Goes to the RETAS! PRO home page if you have internet access.

View the latest information and download updates from the home page.
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Apple Menu  

About CoreRETAS...
View the current CoreRETAS version information.

This information will be required if you need to call technical support.
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Commands & Tools

Making A Selection
Click or drag to make a selection in the x-sheet. Parameters entered in the Input Field can be

registered in a selection.

Click a data cel to select one frame. Drag a range of frames and/or layers to make a larger

selection.

       

Shift-click also selects a range of selection.

Press an arrow key to move a selection. After each input, the selection also moves down

automatically.
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If your selection moves out of sight, the x-sheet scrolls automatically to follow your selection.

If you click a layer title bar, it becomes the current layer but the selection does not follow the

current layer.

If a selection is in an "effects layer" or a "sub-cel layer" when you collapse the sheet, the

selection moves to the cel layer.

A selection cannot come between different types of layers (cel layer, sub-cel layer, camera

layer or effects layer).

Also, a selection cannot be cross between 2 effects layers.

Keyframe Settings
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CoreRETAS manages the various parameters in an x-sheet frame by frame.

Parameters can be input frame by frame. Except for the "cel number", you can set only some

key point frames, then CoreRETAS automatically creates the rest of the parameters in other

frames.

These key point frames are called "Keyframes".

Creating parameters between the keyframes is called "InBetweening".

There are 2 kinds of keyframes: "Continuous-Keyframe" & "Noncontinuous-Keyframe"

1. Continuous-Keyframe  
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"Continuous-Keyframe" creates a continuity between itself and other previous or following

keyframes.

It becomes a "center point" for InBetweening.

Sample: Continuous-Keyframe Setting

1-1. Create a new x-sheet with 60 frames and 4 layers.

1-2. Make sure the Auto InBetween switch  is on.

Set InBetween speed to "Uniform".

Set view mode to "All Frames" , and turn on "Frame Path" .

1-3. Set Frame 1 To Keyframe

Click position button  and then move the "CAM" pegbar.

1-4. Set Frame 60 To Keyframe

Click position button  and then move the "CAM" pegbar.
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1-5. Set Frame 30 To Keyframe

Click position button  and then move the "CAM" pegbar.

"Auto InBetween" has created a smooth curve on the frame path between "frame 1", "frame

30" and "frame 60".

2. Noncontinuous-Keyframe  
"Noncontinuous-Keyframe" does not create a continuity between itself and other previous or
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following keyframes.

It becomes a regular "starting point" or "ending point".

Sample: Noncontinuous-Keyframe Setting

2-1. Create a new x-sheet with 60 frames and 4 layers.

2-2. Make sure the Auto InBetween switch  is on.

Set InBetween speed to "Uniform".

Set view mode to "All Frames" , and turn on "Frame Path" .

2-3. Set Frame 1 To Keyframe

Click position button  and then move the "CAM" pegbar.

2-4. Set Frame 60 To Keyframe

Click position button  and then move the "CAM" pegbar.
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2-5.  Set Frame 20 To Keyframe

Click position button  and then move the "CAM" pegbar.

Now, Alt/Opt-drag the "CAM" pegbar to move it.

Alt/Opt-drag sets a "Noncontinuous-Keyframe".

"Auto InBetween" has created a sharp angle on the frame path between "frame 1", "frame

20" and "frame 60".

3. Continuous-Keyframes & Noncontinuous-Keyframe Mixed
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Repeat step "2. Noncontinuous-Keyframe".

3-1. Set Frame 40 To Keyframe.

Click position button  and then move the "CAM" pegbar.

Frame 40 is now set to Continuous-Keyframe.

When CoreRETAS inbetweens the 4 keyframes "frame 1, 20, 40 and 60", since "frame 20" is

a "Noncontinuous-Keyframe", no matter where you move "frame 40", "frame 1 and 20" are not

effected.
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InBetween

1. InBetween Settings Dialogue

Choose "Sheet -> InBetween -> Setup...".

A. Speed
Speed options.

A-1. Accelerate
To increase the speed gradually.

Mostly used for camera/cel fairing at the start of a move.

A-2. Decelerate.
To decrease the speed gradually.

Mostly used for camera/cel fairing upon stop.

A-3. A >> D
To accelerate, then decelerate

Mostly used for pans.
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A-4. D >> A
To decelerate, then accelerate.

Mostly used for changing transparency rather than for camera works.

A-5. Uniform
Always the same speed.

A-6. Graph Setup
Setting of speed using a graphical editor.

A-7. Graph Area
Edit the graph in this area. Horizontal lines indicate the time, vertical lines indicate the speed.

The default (reset) graph is a straight line, indicating "Uniform" speed.

A-8. Graph Settings
Click anywhere to add a control point.

Drag the control point to edit the curve.

With 1 control point, if the curve expends downwards, it indicates "Acceleration". The more

the curve deviates, the faster the acceleration.

With 1 control point, if the curve expends upwards, it indicates "Deceleration". The more the

curve deviates, the faster the deceleration.

The maximum number of control points can be added is 2.

Click somewhere else to add the second control point.

With 2 control points, complicated settings can be achieved.
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The above figure demonstrates an acceleration and a deceleration.

Move a control point again to modify the curve.

• Load...

   Loads a saved "Graph Setting" file. (File extension *.ibf)

• Save...

   Saves the current setting as a file. (File extension *.ibf)

• Revert

   Reverts the current curve.

   If the current curve is an acceleration, it becomes a deceleration.

• Reset

   Deletes all control points and resets to uniform speed.

• Cancel

   Ignores the setting and closes the dialogue.

• OK

   Proceeds with the current setting.
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• Speed Confirmation Bar

  An easy view of the current speed setting.

A-9. Spline
Inbetweens multiple keyframes with spline.

To learn about this option, go to "Notes About InBetweening" in "Commands & Tools".

A-10. Integer Only For Position InBetweening
Position InBetweening value becomes integer only.

Since the Position InBetweening does not calculate decimals, rendering time can be

reduced.

A high speed movement has no visual problems even if the decimals are not calculated.

A-11. InBetween Same Cel Number
Usually this option is on.

When activated, the same cel numbers are inbetweened.

If you don't want a character's foot to slide during a walk or run, turn off this option.

When it is off, the same cel numbers will have the same position value.

A-12. Match Position And Speed InBetweening On Stage
To learn about this option, go to "Notes About InBetweening" in "Commands & Tools".
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Notes About InBetweening

A. Position InBetween

A-1. If "Spline" Is Not Selected
There are 2 elements in Position InBetweening. One is the path, the other is the speed.

With both elements satisfied, the following situations may appear.

A-1a. If multiple keyframes exist, the middle one's position may be adjusted.
The original position will remain somewhere on the path.

The above uniform speed path with 7 frames and 3 keyframes becomes the path below if set

to "Accelerate".
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A-1b. When "Match Position And Speed InBetweening On Stage" is checked, if you

move the middle keyframe among 3 keyframes, its position will be adjusted

automatically.

A-2. If "Spline" Is Selected
The middle keyframe's original position will remain unadjusted.
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B. Other InBetweens

B-1. If "Spline" Is Selected"
Multiple keyframes will be inbetweened using "Spline" method.

"Spline" will treat all the "continuous-keyframes" within a selection as a whole and separate

the "noncontinuous-keyframes".

    [One selection]

Furthermore, "Spline" will not automatically adjust the keyframes positions.

B-2. If "Spline" Is Not Selected
If there are 3 or more keyframes within a selection, CoreRETAS will treat each keyframe

separately according to the settings.

Sample: When "Accelerate" is selected

    [One selection]

     Accelerate      Accelerate      Accelerate

If all the above "continuous-keyframes" are changed to "noncontinuous-keyframes", the

result will be the same.

[One selection]

Accelerate        Accelerate        Accelerate

This could also prevent the keyframes from being modified.
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About Reading A Scene Folder

To open a "scene folder", choose "Open Scene Folder...".

If no "Management File" (extension *.mng, created by TraceMan) is found in the folder, an

error message appears.

If no management file is found, look for an "x-sheet" file (extension *.tsf) in the same folder.

If an x-sheet file is found, open it.

If no x-sheet has been created yet, the management file will create a new one automatically.

A. X-sheet
A name is automatically created by the "management file".

B. Frames
The number of frames is automatically created based on the settings when created by

TraceMan.

C. Layers
The number of layers is automatically created based on the settings when created by

TraceMan.

D. Camera Size
The camera size is automatically created based on the settings when created by TraceMan.

E. Standard Resolution (DPI)
The standard resolution (DPI) is automatically created based on the settings when created by

TraceMan.
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F. "Information"
The following info can be viewed by choosing "Sheet -> Information".

   • Title

   • Episode Number

   • Sequence Number

   • Scene Number

The above 4 items are automatically created based on the settings when it was created by

TraceMan.

G. CelBank Auto Import
Automatically imports all cel folders from the scene folder to the celbank.

H. Layer Auto Setup
Automatically sets "Mono Trace" layers to "White Transparent", and "Gray Trace" layers to

"Alpha Channel".

I. Layer Auto Link
Automatically links celbank "A" to layer "A", and celbank "B" to layer "B".
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About Markers

"Marker" is a newly added feature in CoreRETAS version 5.

A marker is a bookmark on the x-sheet.

A marker is used for instantly calling up a frame, and/or making a selection.

1. Make A Marker
1-1. Click a frame number.

1-2. Hold Alt/Opt key and press a number key between "1" ~ "10".

[Figure: Make a maker / "1" is pressed]
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2. Call A Marker
Sample: To call up marker "1".

2-1. Hold Shift key and press "1".

2-2. Marker "1" appears in the x-sheet window center.

Note:

When you call a marker, the current frame does not follow.

If you want to call up the current frame, use "Current Frame" command.
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3. Use Markers To Make A Selection
Sample: To make a selection between marker "2" and "3".

3-1. Hold Shift key and press "2" and "3" simultaneously. (Shift + 2 + 3)
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About Compositing Modes

1. Normal
Each pixel of the current layer reflects its original RGB value, no changes.

2. Add
Adds the RGB value of each pixel to the layer below.

3. Lighter
Lighter pixels are shown based on a comparison with the layer below.

4. Darker
Darker pixels are shown based on a comparison with the layer below.

5. Subtract
Subtracts the RGB value of each pixel from the layer below.

6. Difference
Absolute value of the difference in RGB based on a comparison with the layer below.

7. Multiply
Multiplies the RGB value with the layer below, then divides by 255.

8. Screen
Inverses the RGB value of both layers, multiplies them, then inverses again.

9. Backlight
Adds a backlight mask. To learn more, go to "Add & Backlight" in "Commands & Tools".

10. Gray Mask
Makes the layer as Gray Mask. To learn more, go to "About Masking" in "Commands &

Tools".

11. Alpha Mask
Uses the layer as Alpha Mask. To learn more, go to "About Masking" in "Commands &

Tools".
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About Effects layers

An Effects layer allow you to add special effect plug-in filters.

Select a special effect from the sub-menu under "Effects" menu to add it.

A new effects layer is added to the right of a cel layer.

An additional effects layer is always added to the very right.

To learn about special effects, go to "Standard Plug-in Filters" in "Commands & Tools".

Effects layers are processed in left-to-right order.

To change the order, drag and drop the effects layer.

Click an effects layer title bar.
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Drag the layer to left or right, the cursor changes to a double-arrow, a red marker appears indicating

an insertion location.

When the red marker indicates your desired location, release the mouse button to drop the

effects layer.

To copy an effects layer, Alt/Opt-drag and drop
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To delete an effects layer, drag it out of the x-sheet window.

[Figure: Drag an effects layer out of window]
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Effects Order

If effects layers executed in different order, the results will be different.

Sample 1: Focus (Lens = 5) -> Noise (Intensity = 50)

[Figure: 400% enlarged]

Focus effect first, then Noise effect.

Sample 2: Noise (Intensity = 50) -> Focus (Lens = 5)

[Figure: 400% enlarged]

Noise effect first, then Focus effect. Noise effect becomes weaker than sample 1.
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Standard Plug-in Filters

CoreRETAS version 5 standard plug-in filter list and explanations.

Terms
CelBank : required or not

Parameters : selectable parameter type

Settings : options in "Setup..."

1. Soft Blur
Applies soft-blur to a layer.

  CelBank : Not required

  Parameters : None

  Settings : Soft Blur Setup

    • Repeat ? Times
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2. Focus
Applies out focus (strong blur) to a layer.

  CelBank : Not required

  Parameters : Lens

  Settings : None
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3. Smoothing
Simulates camera focus by application of a strong blur to a layer.

Same as "Smoothing" in "Layer Setup".

  CelBank : Not required

  Parameters : None

  Settings : Smoothing Setup

    • Interior-Edge Smoothing Only on/off
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4. Noise
Adds noise to a layer.

  CelBank : Not required

  Parameters : Intensity

  Settings : Noise Setup

    • RGB Noise

    • HSV Noise
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5. Invert
Inverts a layer.

Same as a negative-positive inversion.

  CelBank : Not required

  Parameters : None

  Settings : None
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6. Alpha
Converts a layer to Alpha mask.

  CelBank : Not required

  Parameters : None

  Settings : Alpha Setup

    • Invert on/off
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7. Backlight
Converts a layer to a Backlight Mask.

  CelBank : Not required

  Parameters : Intensity

  Settings : Backlight Setup

    Base Color, Hilite Color

To learn more, go to "About Backlight" in "Commands & Tools".
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8. Backlight2
Converts a layer to Backlight Mask.

Difference from "Backlight": no need to blur the mask.

  CelBank : Not required

  Parameters : Intensity, Spillover

  Settings : Backlight Setup

    Base Color, Hilite Color

To learn more, go to "About Backlight" in "Commands & Tools".



240

Chapter 6-4    Commands & Tools

9. Mask Replace
Adds an additional mask layer.

  CelBank : Required

  Parameters : Mask number

  Settings : Mask Setup

    • Original Mask on/off

    • Use RGB Mask on/off

    • Invert Mask on/off

To learn more, go to "About Mask Replace" in "Commands & Tools".
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10. RGB Filter
Adds an RGB filter to a layer.

  CelBank : Not required

  Parameters : R Filter

  G Filter

  B Filter

  Settings :RGB Filter Setup

    Red, Green, Blue
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11. HSV Filter
Changes the color tone of a layer.

  CelBank : Not required

  Parameters : H Filter

  S Filter

  V Filter

  Settings : HSV Filter Setup

    Hue Angle, Saturation, Value
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12. Mirror
Reverses a layer's images either horizontally or vertically.

  CelBank : Not required

  Parameters : Apply (0 = on, 1 = off)

  Settings : Mirror Setup

    Horizontal, Vertical
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13. Distort
Uses a mask layer to distort a cel layer's images.

  CelBank : Required

  Parameters : Mask Number, Intensity

  Settings : None

To learn more, go to "Nesting" in "Commands & Tools".
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About Backlight

CoreRETAS uses backlight mask images (grayscale) to determine backlighting.

How To Use "Backlight" Filter
Sample images

1. Create a new x-sheet.

2. Import images to celbank "-BG" & "A".

3. Link layer "-BG" to celbank "-BG", and layer "A" to celbank "A".

4. Set Layer Setup palette.

-BG : Opaque

A : Backlight

5. Select cel layer "A" and add "Backlight" filter.

6. Enter a value for "Intensity". (For example: "1.2")

7. Choose "Setup..." under "Effect" to set up "Base" & "Hilite" colors.



246

Chapter 6-4    Commands & Tools

"Hilite" color is the light source, "Base" is the overlapping color that surrounds it.

In the following sample, "Hilite" is set to white (RGB = 255, 255, 255), "Base" is set to red

(RGB = 255, 0, 0).

If you use another compositing mode instead of "Backlight", such as "Add" or "Screen", the

result will be different.
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Backlight & Parameters

Backlight masks are 0 ~ 255 grayscale images.

In the following mask, the back portion (RGB = 0, 0, 0) is for the "Hilite" color, the

surrounding gray portion is for the "Base" color.

The white portion (RGB = 255, 255, 255) does not reflect any color no matter how strong the

parameter is set to.

If the "Intensity" is set to 0, no backlight will be produced. The greater value the parameter is

set to, the lighter the "Hilite" color will be, in relation to the "Base" color. But if the parameter is

too strong, "Hilite" color will start leaking out from "Base" color.

The "Backlight" filter requires an image to be blurred around the edge in order to express

spillover of light. The "Backlight2" filter has an "Spillover" control, so it does not require the

mask to be blurred.

[Figure: Mask]

We will use the above image (mask) to create backlights.

Set the layer compositing mode to "Backlight".
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Set both "Base" & "Hilite" to white.

If the parameter is set to too strong, it all becomes "Hilite" color.

Set "Hilite" to black and "Base" to white.
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Set "Hilite" to white and "Base" to black.

Set both to black.

Try different settings with other colors and parameters. If you can master the various

combinations, you will be able to create effects like "shining objects" or "darkness spreading".

Note:

   To express a "dark light", use "Backlight" mode.

   Principally, "Add" and "Screen" mode cannot express a "dark light" effect.
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BG Backlight

CoreRETAS backlight expression is different from the "Backlight" in traditional film. Only

layer below the backlighting effect are effected. Other layers besides the backlight layer are not

effected.

For example, if you want the "BG Layer" to be the backlight source and set it to backlight

mode, no light will come out from a cel above it, but only a flat background because it is the

lowest level.

In this case, create a backlight mask as in the following sample, attach it as a layer above the

cels, and set it to backlight mode.
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About Focus

Cel Focus & Camera Focus
There 2 types of focus: "cel focus" & "camera focus".

"Cel focus" means to add a "Focus Filer" to a layer and blurs it.

This is used for creating multiplane camera effects.

[Figure: Layer focus]

It applies focus (blur) to a cel layer before it is composited with other layers.
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A "camera focus" applies focus after all cel layers are composited.

[Figure: Camera focus]
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Focus & Scale Value Relationship

An out-of-focus result is affected by a layer's scale value.

If focus is applied after a scale change, the blur effect may disappear.

["Blur" = 3, scale = 100]

["Blur" = 3, scale = 30]

In other words, a smaller scale weakens a focus effect. In this case, set the focus value

greater depending on the scale value.
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About Motion Blur Effect

A high speed train passing, a quick camera pan. These kind of scenes are often seen in a

film or video. Some of the images are blurry. This blurry effect is produce by a fast movement

with a slow shutter speed because a clear image could not be captured.

"Motion Blur" is to simulate this fast motion blurry effect.

What Is Motion Blur Effect Suitable For?
The "Motion Blur" effect can be configured in the camera layer and all cel layers.

If the camera layer is configured for motion blur, all cel layers will be effected.

Intensity of a motion blur (blur level) depends on its value in x-sheet (0 ~ 100), frames

moving speed and rotation angles.
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Note About Motion Blur
How blurry a "Motion Blur" is depend on the speed of the movement of a camera or a cel.

If the camera or a cel does not move, no motion blur effect will be produced no matter how

great the parameter is set to.

[Figure: Motion blur applies to a fixed cut]
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About Masking

A mask allows control over the visibility of the lower and the upper layers.

There are 2 types of mask: "Gray Mask " and "Alpha Mask".

Gray Mask
A "Gray Mask" can be either a 24 or 32 bit image.

(In both 24 bit and 32 bit images, the RGB plane will be converted to grayscale for use as a

gray mask.)

The Alpha channel of an image, if any, will not be used.

Black (RGB = 255, 255, 255) pixels in the mask image will make the lower layer visible.

Here, "lower layer" means the composited results of all layers below the "Gray Mask" layer.

White (RGB = 0, 0, 0) pixels in the mask image will make the upper layer visible.

Here, "upper layer" means the layer directly above the "Gray Mask" layer.

Please note this "upper layer" is different from that in CoreRETAS version 4.

The darkness of a pixel in the grayscale mask determines the transparency of the mask.
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[Figure: Composited layers]

[Figure: from left -> BG layer/mask image (RGB plane)/A layer]

[Gray Mask composited result]
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Alpha Mask
An "Alpha Mask" must be a 32 bit image because the Alpha channel of the image is used as

mask. A RGB image cannot be used as an Alpha Mask.

Otherwise, the function of an Alpha Mask is the same as a Gray Mask.

If you want to use a 24 bit image as an Alpha Mask, set it to "Alpha Channel" mask mode in

order to create an alpha channel, then use this alpha channel as a mask.

Black (RGB = 255, 255, 255) pixels in the alpha channel will make the lower layer visible.

Here, "lower layer" means the composited  result of all layers below the "Alpha Mask" layer.

White (RGB = 0, 0, 0) pixels in the alpha channel will make the upper layer visible.

Here, "upper layer" means the layer directly above the "Alpha Mask" layer.

Please note this "upper layer" is different from that in RETAS! PRO version 4.

The darkness of a pixel in the alpha mask determines the transparency of the mask.
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About Mask Replace

How To Use The "Mask Replace" Plug-in Filter
"Mask Replace" uses a new layer as a mask rather than the original cel layer's alpha

channel.

Sample Sheet
Set "-BG" & "A" layer to "Opaque".
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Material CelBank "-BG"

Material CelBank "A"

CelBank "A" image contains the following alpha channel.
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Material CelBank "Mask" (24 bit)
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Sample 1:Original Mask Off

Use RGB Mask On

Invert Mask Off

A cel

Alpha channel created by Mask Replace filter

Composited result
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Sample 2:Original Mask On

Use RGB Mask On

Invert Mask Off

A cel

Alpha channel created by Mask Replace filter

Composited result
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Sample 3:Original Mask On

Use RGB Mask On

Invert Mask On

A cel

Alpha channel created by Mask Replace filter

Composited result
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About Smoothing

"Smoothing" is to smooth out "rough" or "ragged" lines. This is normally called "antialiasing"

and the ragged, stair step edges are "aliased".

CoreRETAS can automatically find lines and adjust only the aliased portion.

It may sound like a Blur, but is completely different.

A "Blur" softens the entire image and decreases the contrast.

"Smoothing" does not change the contrast and only revises the aliased portion of the line to

make it smooth.
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There are 2 types of smoothing: "cel smoothing" & "camera smoothing".

"Camera smoothing"  smooths the final result after all layers are composited.

To use it, select the camera layer in "Layer Setup" palette and click the check box.

"Cel smoothing" smooths a cel layer before it is scaled and composited.

To use it, select a cel layer in "Layer Setup" palette and click its check box.

"Camera smoothing" is not effective on a mono-traced cel layer when it is scaled and

focused. Use "Cel smoothing" instead.

Normally, when "Auto" is set in the "Smoothing" option of the "Rendering Settings",

CoreRETAS will automatically determine the amount of layer smoothing necessary. It is

recommended that the default setting be used.
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Alpha Channel Compositing

Alpha CHANNEL COMPOSITING is used for compositing images created by 3D programs.

For highest quality results, 3D software applies antialiasing to rendered images, so the

boundary line (edge) may look dirty when composited in White Transparent mode with

CoreRETAS.

In this situation, use alpha channel mode instead.

Export the images from the 3D software in 32 bit mode, import them in CoreRETAS, and set

"Mask" mode to "Alpha Channel" in the "Layer Setup" palette.
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Color Para / Para Overlay

There is a technique called "Color Para" or "Para Overlay" in traditional cel animation.

This technique places a colored paraffin paper in front of camera lens to create a colored shadow.

CoreRETAS can create this "Color Para" effect by using the alpha channel compositing.

Below, the RGB channel is all back and the alpha channel has a black-and-white silhouette

"para", then is blurred.

[RGB plane]

[Alpha plane] [Alpha plane (blurred)]



Chapter 6-4    Commands & Tools

269

Composited result.

In this sample, the "para" layer was set to 80% transparency in order to adjust its darkness.

If desired, you can invert the black-and-white image.



270

Chapter 6-4    Commands & Tools

Advantages Of Add

Here we detail the advantages of "Add" mode versus the "Backlight" mode.

Similar to "Backlight", "Add" is also used for simulating light.

"Add" is to add up the pixel values of 2 layers. The result is same as a double-exposure as

traditional film.

Add is performed in the RGB channel, 255 is the maximum the value can reach.

Since this is the same as a double-exposure, please note the following:

1. Do not use a bright background.
Lit material will not be seen on a bright background.

2. Lower material should not be too bright.
A material that is too bright will exceed 255 after it is added and will become completely

white.
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-BG layer

A layer

B layer (Add mode)
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[Figure: Composited result]

In the above sample, after the text is added to the white portion of the character cel, it

becomes completely white (it has exceeded 255).
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Add And Backlight

Here we describe the difference between Add and Backlight.

On the left is the "Add" result with transparency changes, on the right is the "Backlight" result

with intensity changes.

    [Add] [Backlight]

In "Backlight" mode, the flare spreads less when light intensity is low. In "Add" mode, the

flare depends on the material.

In "Backlight" mode, the background becomes invisible when the light becomes stronger. As

in "Add" mode, the background is always visible.
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Also, in "Add" mode, the triangle shape has collapsed when the light gets too strong.

Since the Add mode easily affects the background, it is more suitable for simulating weaker

light.

Sample: A flare material used in Add to create a soft light.
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About Exposure Effects

CoreRETAS uses "RGB Filter" to create exposure effects as in traditional film.

Fade In & Fade Out
Sample: To create a fade-in in the first 18 frames.
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We will use a RGB filter in the camera layer.

Select the camera layer, then choose "Effect -> Add... -> Tone -> RGB Filter".

Select "R Filter" from the "Input Parameter Select Menu" of the "RGB Filter".

The "R Filter" is shown 0(%) by default.

We will set the fade-in starting frame at frame 1 and the ending frame at "frame 18" as

keyframes in order to do auto inbetweening.

Select frame 1, type "-100" and press the Enter key. Then choose "Set Continuous-

Keyframe" command.
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Select frame 18, type "0" and press the Enter key. Then choose the "Set Continuous-

Keyframe" command.
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Set both the "G Filter" and "B Filter" of frame 1 to "-100".

Set both the "G Filter" and "B Filter" of frame 18 to "0".
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Next the InBetweening.

If you set the inbetween speed to "Uniform", the fade-in will seen too short. To make it look
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more natural, We will set the speed to "D >> A".

Choose "Sheet -> InBetween -> Setup..." to bring up the dialogue.

Click the "D >> A" speed option, then click "OK".

Drag the mouse between the 2 keyframes to select, then choose "InBetween" command.

That's how to create a fade-in.
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[Figure: Fade-in sheet]

To create a fade-out, reverse the RGB filter value from 0% to -100%.

To create a white-in or white-out effect, use a positive value (100%) instead of a negative (-

100%).

Nesting
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CoreRETAS version 5 can import x-sheets into a celbank as well.

This figure demonstrates that an x-sheet is imported into celbank "A".

[Figure: File type in this celbank is "*.tsf".

This sheet-in-sheet feature is called "Nesting".

Sheet nesting allows real time editing/confirmation of an x-sheet. This requires the sheet to

be pre-exported in CoreRETAS version 4.

Also, nesting gives you more control over complicated special effects.

Note:

A nested sheet does not display images on the stage even though it is in "Image" mode.

Nesting Sample
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Here we will see how to add an image distortion (ripple glass) effect by using sheet nesting.

Sample data can be found on the RETAS! PRO CD-ROM.

A nest sheet and a nested sheet need to be created first.

1. Create a nest sheet
Choose "New X-sheet" and create a sheet with 150 frames and 1 layer.

2. Import an image and assemble the sheet
Import an image "-BG" in celbank "-BG".
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Set the "-BG" layer to "Normal" and "Opaque" in the Layer Setup palette.

Double-click the "-BG" layer title bar to select the entire "-BG" layer, then enter "1" as the cel

number.
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Save the sheet as "SheetNest.tsf".
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3. Create a nested sheet
Choose "New X-sheet" and create a sheet with 150 frames and 1 layer.
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Choose "Sheet -> Layer -> Rename..." and change the "-BG" layer name to "mask".

Choose "Sheet -> Pegbar -> Rename..." and change the "-BG" pegbar name to "mask".

Choose "Sheet -> CelBank -> Rename..." and change the "-BG" celbank name to "mask".
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4.  Import an image and assemble the sheet
Import the "mask" file into celbank "mask".

Set the "mask" layer to "Normal" and "Opaque" in the Layer Setup palette.

Turn on Tiling "X".
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Double-click the "mask" layer title bar to select the entire "mask" layer, then enter "1" as the

cel number.
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5. Camera work
Open the stage window, and select "CAM" by clicking the "Pegbar Select Button".
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Here We will slide the "mask" cel to create a moving mask.

Make sure frame 1 is the current frame.

If not, use the stage control panel to move to frame 1.

Click the "Pegbar Select Button" on stage and select "mask".



Chapter 6-4    Commands & Tools

293

Click the "P Position X" field on stage to select it.
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When the field is highlighted, click the Continuous-Keyframe button to set it as a keyframe.
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Next, use the stage control panel to move to the last frame (frame 150).

Click the "P Position X" field on stage to select it.
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Type "-2000" in the "P Position X" field and press the Enter key to confirm it.
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While the "P Position Y" field becomes highlighted, click the Continuous-Keyframe button to

set this frame as a keyframe.
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Select "P Position X" from the Input Parameter Select Menu under "mask" layer.
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Double-click the "mask" layer title bar to select all frames.
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Choose " Sheet -> InBetween -> "Setup..." to bring up the dialogue.

Select "Uniform" and then click "Apply".
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Save the sheet as "mask.tsf".
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6. Sheet nesting
Open "SheetNest.tsf" saved in step 2.
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Select "-BG" as current layer.

Choose "Effects -> Add -> Distort -> Distort".
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Choose "Sheet -> CelBank -> Insert..." to add a celbank "mask".

Import "mask.tsf" saved in step 5 into celbank "mask".

In the celbank import dialogue, select "X-sheet" as the file type and then double-click

"mask.tsf" to import it.

The difference from importing image files: a nested x-sheet does not display thumbnails.
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In the effects layer "Distort", change the CelBank Select Menu from "=" to "mask".
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Make sure the Input Parameter Menu is in "Mask No." mode.
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Choose "Sheet -> Cel Number Auto Input".

Follow the figure below and then click "OK".
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Select "Intensity" from the Input Parameter Menu.
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Double-click the effects layer "Distort" title bar to select all frames, then enter "50".
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Double-click frame number 1 to render the frame.

To check the animation, export it to a QuickTime movie.
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About RLA Files

CoreRETAS version 5.1 is able to import RLA files using the RLA plug-in.

The RLA file is created by 3D Studio MAX and contains various options.

The RLA plug-in must be installed in order to read the RLA files.

The RLA plug-in for RETAS! PRO is able to read "Object ID" and "Z Depth" options.

Sample of Using An RLA File
Click the "Import" button in the celbank palette and the Open dialogue appears. Select an

RLA file and then click "Open".
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"3D Studio MAX RLA Setup" dialogue appears.

Turn on the "Preview" button to see the image in the preview area.

The "3D Studio MAX RLA Setup" dialogue has 3 options: "Ignore Options", "Z Depth" and

"Object ID".

A. "Ignore Options"

This will ignore all options in the RLA file and import it as a regular still image, which is similar

as reading a Targa or other 2D image files.
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B. "Z Depth" Option

This will import the "Z Depth" information in the RLA file and then you can use the "P Position

Z" to define the number of pixels in Z depth to be visible.

CoreREAS can control the transparency/opaque by pixels.

The pixels deeper than the Z depth value of "P Position Z" will become "transparent (RGB:

255, 255, 255)".

P Position Z = -280

P Position Z = -1000
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 +  + 

BG ("Ignore Options") A cel    B cel (P Position Z = 280)

=  

             Composited result
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By controlling B cel's "P Position Z", the 2D character can enter in-between the 3D objects.

P Position Z = -280.0

P Position Z = -265.32

P Position Z = -257.02

P Position Z = -250

Please note that the transparency/opaque control through "P Position Z" is only effective

when the RLA files have been imported with "Z Depth" option.
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In order to use the "Z Depth" option, the "Z Depth" and "Z Coverage" options must be turned

on when exporting RLA files from 3D Studio MAX.

For details about "Z Depth", please see the 3D Studio MAX manual.
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C. "Object ID" Option

The RLA plug-in is able to identify each individual object by its original ID stored in the RLA

file and import the desired object by its ID into the celbank.

Sample of Objects

Object ID = 1 Object ID = 7

Object ID = 2 Object ID = 9

Object ID = 3 Object ID = 10

Object ID = 4

 (Note: Objects of ID = 5, 6, 8 are abandoned.)
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In order to use the "Object ID" option, the "Object" and "Z Coverage" options must be turned

on when exporting RLA files from 3D Studio MAX.

For details about "Object", please see the 3D Studio MAX manual.
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Technical Information

Notes About Cut And Paste

1. "Cut" and "Copy" will transfer all parameters to buffer no matter what is selected in

the x-sheet's "Input Parameter Select Menu".

"All parameters" means all selectable parameters in "Input Parameter Select Menu" listed

below.

Parameters transferred to buffer by "Cut" and "Copy":

Cel Number (Note 1)

----------

P Position X

P Position Y

P Position Z

P Scale X

P Scale Y

P Rotation

P Center X

P Center Y

----------

Position X

Position Y

Scale X

Scale Y

Rotation

Center X

Center Y

----------

Transparency(Note 1)

Motion Blur

  (Note 1: camera layer does not have "Cel Number" or "Transparency".)

"Cut" and "Copy" cannot transfer only a selected parameter .
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2. "Paste" will transfer all parameters that have been copied.

To paste only selected parameters, use "Selective Paste" command.
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About Edge Smoothing

CoreRETAS version 5 always exports images in 32 bit file format containing an alpha

channel.

(Thus the "Add Alpha" check box in "Layer Setup" palette no longer exists.)

The Edge Smoothing (antialiasing) target is the alpha channel, not the RGB plane.

If there is no image below a cel (either mono or gray-traced), you will not see any edge

smoothing (antialiasing) in the RGB plane in the rendered result. Instead, you will see edge

smoothing (antialiasing) in the alpha channel, which is good for compositing with other images

in other programs.

[Rendering Window]

[With background] [Without background]
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100Frame & Standard Resolution

RETAS! PRO ∞ system has implanted the concepts of "100Frame" & "Standard Resolution".

This makes it easier to calculate the resolution and easier to understand.

"100frame" is a popular term in the Japanese animation industry. A fixed camera scene is

considered a "100frame". (Traditionally, it was equivalent to 9.5 field.)

To indicate a track in or track back, you can use terms like "TU to a 50frame" and "TB to a

150frame".

The concept of a "100frame" in RETAS! PRO is based on X, Y coordinates according to a

fixed "100frame". A "100frame" is a "frame at 100% size" and its half size in both width & height

is called a "50frame". Its double size in both width & height is called a "200frame'.

"Standard Resolution" indicates the size (X, Y coordinates) of a 100frame, scan resolution

(DPI) and number of pixels in the X and Y directions.

In older versions of RETAS! PRO resolution was based on "DPI".

Not only is the DPI based resolution hard to understand but also it does not provide enough

information for real production. Very often, the formula "1 pixel = ? mm" or "1 pixel = ? inch" is

used to calculate the distance (number of pixels) of a movement.

CoreRETAS version 5 uses pixels as the basic measurement to indicate the coordinate

parameters, and "mm" or "inch" unit if desired.
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About PaintMan Layer Structure

PaintMan uses more than one layer to store images.

The structures of mono-traced images and gray-traced images by TraceMan are slightly

different.

Layer Structure Of A Mono-Traced Image
A mono-traced image has 2 layers: the "Line Layer" and the Color Layer". As shown below,

"Line Layer" holds the black outlines, "Color Layer" holds color-traced lines and paint colors.

[Figure: Layer structure of mono-traced image]
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Layer Structure Of A Gray-Traced Image
A gray-traced image has 2 layers: the "Gray Layer" and the "Color Layer".

The "Gray Layer" holds the black pencil lines with their grayscale information.

When you paint a gray-traced image, it looks like you are painting around the grayscale lines,

but actually you are painting in the color layer and what you are seeing is the composited result

of the painted color layer and the gray layer. If you see a line gap in the color layer, it has

nothing to do with the grayscale lines.

  

  [Figure: Layer structure of gray-traced image]

Otherwise, painting a gray-traced images is the same as painting a mono-traced image.
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About Color Configuration

Computer Color Configuration
A computer has 2 ways to express colors: RGB and HSV.

CoreRETAS can use both methods. Here we will explain the basic method of RGB.

"Color" on computer is the mixture of 3 primary light sources: red (R), green (G) and blue (B).

Full color mode can handle 256 grades of scale from 0 ~ 255 in each channel of Red, Green

and Blue. For example, a 50% gray is a mixture of RGB = 128, 128, 128.

The system Color Picker gives you 256 grades, sampled as below.

(Sample)

Skin R: 252 G: 199 B: 146

Skin (shadow) R: 140 G: 62 B: 35

Skin (highlight) R: 255 G: 232 B: 217

Hair R: 252 G: 199 B: 146

Hair (shadow) R: 157 G: 62 B: 13

About Display Device Color
The colors are configured on a computer display but most projects are usually output to video

or film.

The color display of a video monitor or film may be slightly different from that of a computer

display, so the output color should always be checked on the final output device.
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Exchanging Data With Other Software

Save Format
RETAS! PRO saves images in multi-layer format, which is specially designed for animation

painting. When TraceMan traces an image, it automatically puts the black pencil lines data in a

line layer and the colored lines (RGB) in a color layer.

Outline data is usually not used by other software, so it is stored at the end of the image file.

  [Figure: Layer information stored at the end of an image file]

If an image file traced by TraceMan is opened and re-saved by an application program other

than PaintMan, the layer information will be lost.
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Mono-traced image opened by other applications
    [Opened by PaintMan]       [Opened by other retouch software]

   

Gray-traced image opened by other applications
    [Opened by PaintMan]       [Opened by other retouch software]
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If the images are mono-traced, one of the following methods can be used to separate the

layers again.

 (1). Use PaintMan's "Separate" function in the Batch palette to separate the outlines.

 (2). Use TraceMan to trace again.
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Compatibility With Other Software

When using other graphics software to open RETAS! PRO traced images, the layer

information at the end of the file may be treated as "incorrect information". Sometimes it may

not be opened.

(Such as with Photoshop 4.0 or 5.0 Windows version)

Compatibility Of Gray-Traced Images (PaintMan)
An image gray-traced by version 5 no longer contains the "line layer", but can still be

exchanged with version 4.
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Scene Folder System

Animation production requires a great deal of cooperation when working with large amounts

of image files. If any person names the files and folders in his own way, the file names and

contents may become confusing to others, making subcontracting impossible.

In order to build an effective system of managing large amount of files, RETAS! PRO

manages files by folders.

RETAS! PRO ∞ version 5 uses a new standard file management system. This new file

management system is called the "Scene Folder System".

By using this "Scene Folder System", data can be smoothly exchanged even between

different productions.

The scene folder system keeps all necessary data of a scene stored in its "Scene Folder".
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Scene Folder
A "scene folder" contains the following folders and files.

[Figure: A scene folder sample]

1. Cel Folder
BG (background), A cels, B cels, C cels are kept in individual cel folders.

A folder should be named the same as the layer name.

A layer cels should be placed in the "A" folder, B layer cels in the "B" folder, and so on.

When CoreRETAS reads a "scene folder", if it finds any sub-folders with same name as the

layer folders (-BG, A ~ Z...), and treats them as "cel folders".

CoreRETAS imports the "cel folder" into a celbank and then links it to a cel layer with the

same name.

BG and overlay folders should be named "-BG", "-BK" or "-BOOK", with a hyphen (-) or

underscore (_) inserted at the beginning.

Folders with a "hyphen (-)" and "underscore (_)" at the beginning are ignored by TraceMan's

Batch process.
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2. Sub-cel Folder
Another new concept in RETAS! PRO version 5 is the "sub-cel layer".

There are 2 types of sub-cel layers attached to a cel layer: upper cel and lower cel.

Mainly used for "motion combining". If possible, always use the "lower cel" first.

CoreRETAS automatically searches for cel folders inside a "scene folder", imports them to

celbanks and then sets up their layer mode. If sub-cel folders exist, celbank import will follow

the order shown below.

  [Figure: cel folder with sub-layers]

If a sub-folder inside a cel folder has the same name as the cel folder (-BG, A ~ Z...), it will be

imported into a celbank and linked to a cel layer with the same name.

If a sub-folder inside a cel folder has a name like ["(layer) folder name" + "+"] or ["(layer)

folder name" + "-"], it will be imported into a celbank and linked to a sub-cel layer (upper or

lower) of the cel layer.

Other files or folders will not be imported by CoreRETAS automatically.
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3. Image Files
Images files are stored in cel folders.

The scene folder system names a file as follows.

Layer name + (4 digit) image number + extension

The "layer name" should be a letter indicating A, B cel, etc.

The "number" should be a digit (normally 4 digits).

Numbering starts from "1" not from "0".

An "extension" should be attached unless there is some reason not to.

Sample: A cel folder

  A0001.tga

  A0002.tga

  A0003.tga

  A0004.tga

"

"

  Incorrect values:
  A0000.tga the number starts from "0".

the number must starts from "1".

  A1.tga the number does not have enough digit.

  A0002 no extension

Except for the extension, other portions must follow the naming rules in order to be used with

the RETAS! PRO system. RETAS! PRO manages image files in numerical order so the number

must be in proper ascending order.

To learn more about this, go to "RETAS! PRO File Numbering".

4. X-sheet Files (Extension *.tsf)
An exposure sheet file created by CoreRETAS.
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5. Management Files (Extension *.mng)
These files contain various data required by the applications of RETAS! PRO series.

Only when a management file is in a scene folder will RETAS! PRO be able to recognize it

and perform automatic operations.

The management file can only be created automatically by TraceMan when it creates a "New

Scene Folder". You cannot make this file on your own.

RETAS! PRO applications write necessary data to this management file, and require it to

perform automatic operations.

Please do not move, delete or modify the management file.

If the "management file" has been moved, deleted or modified, an existing x-sheet may

become corrupted, and then you will have to manually modify it.

6. File Management By Folders
RETAS! PRO manages large amounts of files by folders. Please note the following when

managing your folders.

6-1. Moving, copying or deleting must be performed by folders.
RETAS! PRO reads files by the folders. If one file is moved out of a folder, the x-sheet will

lose its overall order.

Even if you only have one image file, always place it in a folder.

6-2. Do not place unnecessary files in a folder.
As above, if you place unnecessary files in a folder, the File Previewer (PaintMan) and

CelBank (CoreRETAS) will lose the numeral order (see "RETAS! PRO File Numbering).

Additional files should be placed in new folders.

6-3. Folders that you do not want to be batch processed
To exclude a folder from Batch processing, insert a "- (hyphen" or "_ (underscore)" at the

beginning of the folder name such as "-BG" or "_temp".
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7. Scene Folder Name Format
Scene folder names are recommended to be in the following format.

  Sample: scene number 12

  S-012

If the scene is a part of a sequence:

  Sample: sequence 07 scene number 20

  S-07-20

If it is a shared scene, use comma to separate the scene numbers.

  Sample: scene 17, 19, 22 sharing

  S-017,019,022

Files scanned with fixed frame for camera work can be placed in a folder named -FRAME (or

-FIELD).

  Sample:

  -FRAME

  -FIELD
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8. RETAS! PRO File Numbering
RETAS! PRO's cel order is not directly linked to a file number.

When RETAS! PRO imports image files from a folder to a celbank, it numbers the cels in the

order imported.

Beginning from 1, it follows the file name sorting order.

Because of this, sometimes the cel numbers in File Previewer (PaintMan) and CelBank

(CoreRETAS) may be different from the file numbers.

  [Figure: Missing number]

In the above sample, A0002.tga is missing, so the cel numbers registered in File Previewer and

CelBank are different from the file numbers.

To avoid this, use the following methods to make RETAS! PRO operation smoother.
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8-1. When an image is missing (deleted)
When an image file has been deleted, the cel numbers in the File Previewer and CelBank are

shifted from the file numbers. This can be corrected by inserting a dummy file.

[Figure: Insert a dummy file (A0002.tga)]

The dummy file should be pure white (RGB = 255, 255, 255), so it will be complete

transparent in the CoreRETAS x-sheet.
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8-2. When adding an image
For example, you can add a new image between the 2nd (A0002.tga) and the 3rd

(A0003.tga).

Normally, it will be added as "A0002a.tag". But if imported into CoreRETAS, the cel numbers

will be shifted.

   

[Figure: "A0002a.tag" is added]

To avoid this, you can give it a larger number so it will appear at the end.

For example, if you name it "A1002a.tga". It will make it easier to recognize the added image since

the number is very obvious.

    [Figure: "A1002a.tag" is added]
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Directory Arrangement

An animation production creates a very large amount of files. If the file names and locations

are not properly determined, other operators may not know where to find data, which will cause

confusion.

Proper control is very necessary to manage RETAS! PRO image data.

The following directory arrangement is recommended for efficient management.

This directory structure is easy to understand and allows error-free file management.

A large system should use a file server as its center, with client machines around it.

    

TraceMan CoreRETAS RenderDog

File server

The following directory structure should be created on the disk of the file server.

  TITLE title

    EPISODE story number and sub-title

      scan scanned scene folder (cels & BG)

      trace traced scene folder (before paint)

      paint painted scene folder

      camera completed camera work scene folder

      output output folder
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Exchanging Data Between Different Platforms

File Names
To avoid trouble when exchanging data between different platforms, be careful with the file

naming.

1. Do not use the following characters in a file name.
[/], [:], [?], [*], ["], [<], [>] or [|].

2. Do not exceed 32 characters.

3. Do not use 2-byte characters

4. Do not use any special characters available only on

certain platform.

5. Always use a file name extension.

About Extensions
Windows recognizes a file by the extension.

The Mac OS does not require an extension, so when it sends files to Windows, Windows

cannot recognize the files.

To avoid this, RETAS! PRO ∞ automatically adds an extension.



352

Chapter 7    Technical Information



Chapter 8    Troubleshooting

353

Troubleshooting

Before Contacting Support
Before contacting user support, please carefully review this list of frequently asked

questions, to see if your question has already been answered.

1. Is your question is answered in the troubleshooting section?

2. Is your system configuration according to the guidelines?

RETAS! PRO requires certain hardware and system software.

Read the "Setup Guide" and double check your system.

3. Is RETAS! PRO correctly installed?

Read the "setup Guide" about installation.

4. Is your copy of RETAS! PRO the most recent version?

New updates correct bugs and incompatibilities. An updated version will show a newer

version number.

Updates can be downloaded from the RETAS! PRO home page at

<http:www.retas.com>.

If your problem is still not solved after the above checks, please contact your dealer.

To ensure smooth support, please provide the following information when you contact

your dealer.

1. Your computer type?

2. Your OS version?

Please provide the exact version number.

3. Your RETAS! PRO version?

Please provide the exact version number.

4. Any error message?

If an error message appears, what is it?

Take note of the error message, it will help us to determine the cause of the problem.
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5. What were you doing when the error occurred?

The more detail the better, including "which command was executed?", "which button

was clicked?", etc.

6. Frequency of the error?

Does a specific operation always produce the same error?

How consistent is the error?

For user support, please contact your dealer.

------------------------------------------------------------
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Q1. CoreRETAS does not launch.
A1. (1) Does your computer meet the correct system requirements?

CoreRETAS has certain CPU, OS and memory requirements.

Double check your computer to make sure it meets the requirements.

(2) The CoreRETAS application may be corrupted.
An error may damage the CoreRETAS application. Reinstalling CoreRETAS

may solve the problem.

------------------------------------------------------------

Q2. CoreRETAS freezes.

I reinstalled CoreRETAS, but the problem is still not

fixed.
A2. (1) Is there any nonstandard software installed on your system?

Nonstandard "device drivers", "extensions" or "control panels" may be

incompatible with CoreRETAS.

Reinstall the standard OS, and see if the problem happens again.

(2) The preferences file may be corrupted.
CoreRETAS' preferences file may be corrupted.

Deleting the preference file only resets CoreRETAS to default settings, it does

not hurt CoreRETAS operation.

* Resetting the preferences file

 Double-click the CoreRETAS icon to launch it, and immediately press the Shift

key.

 Double-click the CoreRETAS icon to launch it, and immediately press the Shift

key.

 Or

 1. Open the "Preferences" folder in the "System Folder".
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 2. Drag "CoreRETAS Pref" to the trash can.

------------------------------------------------------------

Q3. Display color is strange.
A3. (1) Is the monitor set to full color mode?

The monitor must be set to full color mode.

To learn how to set up the monitor, see "Setup Guide".

(2) The display is not correctly adjusted.
Each display's color may be slightly different. Adjust the brightness, contrast

and other settings. To learn how to adjust these, see the manufacture's manual.

------------------------------------------------------------

Q4. Error messages appear: "Not enough memory for UNDO"

or "Not enough memory to execute this command".
A4. (1) Is there another application running?

CoreRETAS requires a lot of memory. Quit other applications to free more

memory and restart CoreRETAS.

(2) Is CoreRETAS given enough memory?
If you're using the Mac OS, go to "About This Macintosh" under the Apple

menu to check the memory usage. If you have an unused memory block, give

CoreRETAS a larger memory size.

If not enough unused memory block can be given to CoreRETAS, adding more

system memory is recommended. Insufficient memory not only limits your file

size, but also may cause problems.

 You can temporarily turn on "Virtual Memory" if absolutely necessary. Virtual

memory is very slow and adding memory is recommended for the long run.

------------------------------------------------------------

Q5. The Open dialogue does not show my image files.

Image files created by other applications cannot be read

by RETAS! PRO.
A5. Double check the file format.
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CoreRETAS version 5 readable file formats are listed in the "A. Image File" in the

"Appendix".

On Windows, file extension must be correct.

On the Mac OS, use a utility such as File Buddy to check a file format.

------------------------------------------------------------

Q6. PICT files saved by Photoshop (Macintosh version) have

noise.
A6. Is the PICT file JPEG compressed?

Some graphic applications can use JPEG compression in QuickTime to compress

PICT files.

JPEG compressed images contains noise. Please do not use JPEG compression.

------------------------------------------------------------

Q7. Cannot save files to disk.
A7. Does the disk have enough available space?

If there is not enough available disk space, images cannot be saved, the OS may

also become unstable. If possible, always make sure there is a minimum of 200 ~

300 MB available disk space.

------------------------------------------------------------

Q8. I deleted a file by mistake.
A8. Use a file utility to unerase it.

Use SYMANTEC's Norton Utilities or similar disk tools to unerase the deleted file.

This method does not guarantee the file will be 100% recovered. So be very careful

when deleting files.
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If a file has been overwritten, there is no way to recover it.

Always make backups.

------------------------------------------------------------

Q9. When using an x-sheet, registered cels cannot be imported.

An "Unable to find the images in CelBank" error

appears.
A9. Did you follow the scene folder rules?

The RETAS! PRO scene folder system manages files by folders.

(1) After files are registered in a celbank, did you move, rename or delete

any of them?
If you move, rename or delete a file, its link with the x-sheet will be broken.

If you recently added an extension to a file, it will also be considered as "file

rename".

(2) Did you move the x-sheet to another location?
Is the x-sheet not inside the scene folder?

If you move the x-sheet, its link with files will be broken.

(3) Did you import files from outside the scene folder?
Do not import files from outside the scene folder, because it often creates

problems.

Always place the image files in the same scene folder as the x-sheet.

------------------------------------------------------------

Q10. Cannot input parameters such as transparency.

After inputting a parameter into a data cel, it is not

visible.
A10. (1) Did you input cel numbers?

If no cel numbers are registered in the x-sheet, the parameters cannot be

entered.

A data cel with a registered cel number will become a colored cel.
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(2) Did you input 2-byte numbers?
Did you press the Enter key after typing the numbers?

If you use 2-byte language input, do not use the number keys on the main

keyboard. Instead, use the number keys on the keypad.

CoreRETAS can only accept 1-byte numbers.

You must press the Enter key after typing the numbers.

------------------------------------------------------------

Q11. When I paste, all other parameters are also pasted.
A11. Did you use the "Selective Paste"?

The "Cut" and "Copy" commands copy all parameters to the clipboard.

The "Paste" command pastes all parameters.

If you want only a certain parameter to be pasted, use "Selective Paste"

command.

------------------------------------------------------------

Q12. When I apply InBetweening, the parameters in the x-

sheet are not inbetweened.
A12. Did you set up keyframes?

"InBewteen" only applies to a selection with 2 or more keyframes. Selections

with only one keyframe or no keyframes cannot be inbetweened.

------------------------------------------------------------

Q13. When I InBetween multiple keyframes, the middle one's

position becomes shifted.

When I move one frame on stage, the current frame also

moves.
A13. Is the "Match Position And Speed InBetween On Stage" option turned on

in "InBetween Setup"?
For details, see "Notes About InBetweening" in "Commands & Tools".
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------------------------------------------------------------

Q14. I wanted a strong shake and entered a large random

parameter, but the shake is not strong.
A14. The parameter in "Random Input" only determines the maximum value of

a shake, it does not mean that the actual shake will be that great.

------------------------------------------------------------

Q15. When I overlap layers, the background can be seen through

them sometimes.
A15. Layer transparency is the combination ratio of 2 layers lying one on top of

another.
If layer A and B are overlapping and layer A's transparency range is set to 100%

~ 0% and layer B's transparency range is set to 0% ~ 100%, the background would

be seen through during the overlap. 50% transparency of A + 50% transparency of

B does not equal 100% opaque. In this case, set only layer B's transparency to 0%

~ 100%.

------------------------------------------------------------

Q16. When I apply camera work to a scaled cel, the

movement looks unnatural.
A16. You may have selected an incorrect speed option for the inbetweening of

the scale and position parameters.
Go back to InBetween Setup and try another speed option.

------------------------------------------------------------

Q17. I applied "Uniform" speed to inbetween a TU/TB, but it

seems to accelerate.
A17. The scale parameter changes the percentage of one side of a cel or the

camera. TU/TB follows the ratio of both sides.
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If you set the speed to "Uniform", it will be correctly doubled.

------------------------------------------------------------

Q18. The size of an imported cel cannot fit onto the stage.
A18. Choose "Preferences" under the "Edit" menu to make the stage size larger than

the cel.
The maximum stage size is limited by the available memory.

If you use large cels, give CoreRETAS more memory.

------------------------------------------------------------

Q19. Smoothing did not make my lines cleaner.
A19. Is the "Smoothing" option in "Rendering Setup..." correctly configured?

If you change the scale or focus of a mono-traced cel, pixels will be

interpenetrated, and the "Smoothing" function no longer works well. In this case,

apply smoothing first before changing scale or focus.

Normally, if you set the smoothing option to "Auto" in "Rendering Setup...", this

problem will not occur.

------------------------------------------------------------

Q20. When exporting, the white part in the BG layer becomes

black.
A21. Is that part of the BG set to pure white (RGB = 255, 255, 255)?

Completely white parts (RGB = 255, 255, 255) become transparent in rendering,

so the real background (behind BG layer) will be visible.

In this case, change the BG layer mode to "Opaque".

------------------------------------------------------------

Q21. I added an effects layer, but the filter does not work.
A21. (1) Is the effects layer turned off?
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(2) Are the parameter and other settings correctly configured?
An effects layer usually requires the configuration of the "parameters" or

"settings".

For details, see each plug-in filter's guide.

------------------------------------------------------------

Q22. Backlight does not look like light.
A22. The mask used for the "Backlight" filter must be blurred in order to

correctly produce the lighting spillover.
"Backlight2" does not require a blurry mask. You can use its light spillover

control instead.

------------------------------------------------------------

Q23. I put a backlight in but no light was produced.
A23. "Backlight" does not affect the layer above it.

No matter how strong you set the parameters, no light will be visible on layers

above the backlight.

To create a backlight behind a character, the backlight mask should be placed

above the character layer.

------------------------------------------------------------

Q24. I applied a "Focus" filter but it does not blur.
A24. Has the scale changed?

If you change the scale of a cel, "Focus" may become less effective.

When rendering, CoreRETAS changes the scale first, then changes the focus

value. For example, if the focus is set to 3 and the scale is set to 50%, the final

rendering result will only be blurred 1.5.

If you change both scale and focus, adjust the focus value according to the scale

change.

For details, see "About Focus" in "Commands & Tools".

------------------------------------------------------------

Q24. No motion blur is visible.
A24. Motion Blur is only visible when there is a "camera/cel movement",

"camera/cel scale change" or "camera/cel rotation".
If there is no movement visible to the camera, no motion blur will be created.
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------------------------------------------------------------

Q25. When I use Photoshop to open the files exported from

CoreRETAS, sometimes the colors appear to be wrong.
A25. Are you using Photoshop v5.0?

Photoshop v5.0 converts colors to sRGB upon opening an image and sometimes

the colors may become slightly strange.

Photoshop v5.0.2 has fixed this problem, so please update to the newer version.

To update, go to the Adobe home page at <http://www.adobe.com>.

------------------------------------------------------------

Q26. When reading an x-sheet created by version 4, the "Link

Layer" information is lost.

A26. Version 5 no longer has the "Link Layer" function, thus the "Link Layer"

information will be lost.
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Appendix
File Extensions List

A. Image Files

B. RETAS! PRO Special Files

Name Extension TraceMan PaintMan CoreRETAS RenderDog Note

TGA   *.tga R/W R/W R/W R/W

PICT   *.pct R/W R/W R/W R/W QuickTime 3 required on Windows

BMP   *.bmp R/W R/W R/W R/W

TIFF   *.tif R/W R/W R/W R/W LZW compression unsupported

Raw File   *.raw -/W -/- -/W -/W

SoftImage   *.pic R/W R/W R/W R/W

RLA   *.rla -/- -/- R/- R/-

YUV   *.yuv -/- -/- -/W -/W

Photoshop   *.psd -/- -/- R/- R/-

QuickTime   *.mov -/- -/- R/W R/W QuickTime required
AVI   *.avi -/- -/- -/W -/W Windows only

Name Extension TraceMan PaintMan CoreRETAS RenderDog Note

Mono Trace Settings   *.t2f +     

Gray Trace Settings   *.tgf +

Tone Curve   *.tcf +

Color Chart   *.ccf +

Color Replace Settings   *.crf +

Color Palette   *.cpf +

Airbrush Effect   *.abf +

X-sheet   *.tsf + +

InBetween Settings   *.ibf +
Management File   *.mng + +
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Field-to-Pixel Sample Chart
"1 field = 1 inch, DPI = dot (pixel) per inch."

Field-to-pixel conversion: Field x DPI = Pixel (Width).

Field Resolution Pixel Height Height Height 100Frame (%) 100Frame (%)
(Inches) (DPI = 72) (Width) (4:3) (16:9) (9:5) (If = 16 Field) (If = 12 Field)

16 72 1152 864 648 640 100% 133%
15 72 1080 810 608 600 94% 125%
14 72 1008 756 567 560 88% 117%
13 72 936 702 527 520 81% 108%
12 72 864 648 486 480 75% 100%
11 72 792 594 446 440 69% 92%
10 72 720 540 405 400 63% 83%
9 72 648 486 365 360 56% 75%
8 72 576 432 324 320 50% 67%
7 72 504 378 284 280 44% 58%
6 72 432 324 243 240 38% 50%

Field Resolution Pixel Height Height Height 100Frame (%) 100Frame (%)
(Inches) (DPI = 144) (Width) (4:3) (16:9) (9:5) (If = 16 Field) (If = 12 Field)

16 144 2304 1728 1296 1280 100% 133%
15 144 2160 1620 1215 1200 94% 125%
14 144 2016 1512 1134 1120 88% 117%
13 144 1872 1404 1053 1040 81% 108%
12 144 1728 1296 972 960 75% 100%
11 144 1584 1188 891 880 69% 92%
10 144 1440 1080 810 800 63% 83%
9 144 1296 972 729 720 56% 75%
8 144 1152 864 648 640 50% 67%
7 144 1008 756 567 560 44% 58%
6 144 864 648 486 480 38% 50%

Field Resolution Pixel Height Height Height 100Frame (%) 100Frame (%)
(Inches) (DPI = 300) (Width) (4:3) (16:9) (9:5) (If = 16 Field) (If = 12 Field)

16 300 4800 3600 2700 2667 100% 133%
15 300 4500 3375 2531 2500 94% 125%
14 300 4200 3150 2363 2333 88% 117%
13 300 3900 2925 2194 2167 81% 108%
12 300 3600 2700 2025 2000 75% 100%
11 300 3300 2475 1856 1833 69% 92%
10 300 3000 2250 1688 1667 63% 83%
9 300 2700 2025 1519 1500 56% 75%
8 300 2400 1800 1350 1333 50% 67%
7 300 2100 1575 1181 1167 44% 58%
6 300 1800 1350 1013 1000 38% 50%
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